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e Publisher’s Foreword

This book is in the Houghton Mifflin Software Solutions Series. The series
is explicitly designed to offer solutions to the problems encountered by ed-
ucators who wish to include instruction on popular commercial application
software programs as a component of courses they teach.

The purpose of this series is to provide high quality, inexpensive—in
fact, remarkably inexpensive—tutorial manuals keyed to the leading
software packages available.

Instructionally Innovative

Each manual in the Software Solutions Series focuses on those features of
a particular program that will actually be used by most individuals. The
manuals do not purport to teach everything there is to know about the
product; to do that, the manual would have to be needlessly complex and
would impose unrealistic time constraints on both students and instructors.
The manuals will enable students to attain comfortable proficiency in the
use of software products.

Flexible

The Software Solutions Series permits instructors to choose the manuals
that best suit their needs. This offers an important advantage over those
manuals that combine coverage of several programs in a single publication
and thus limit flexibility.
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Cost

High

Students enrolled in a computer literacy or business data processing course
often require lab-based instruction on the use of three or more application
programs, usually a word processing program, a database manager, and a
spreadsheet program. This common course configuration can impose a
financial burden on students if they must purchase three expensive manu-
als in addition to the primary course text. We believe the Software Solu-
tions Series goes a long way toward solving this problem by providing an
effective and inexpensive method for learning about software.

Quality

All manuals in the Software Solutions Series are authored by writers who
have teaching experience in the classroom and in training programs in
business and industry. Each manual in the series has been reviewed for ac-
curacy and pedagogical effectiveness.

Software Program Disks

The Software Solutions Series currently consists of seven manuals and soft-
ware for the following products: Microsoft Works, WordPerfect, Word-
Star, dBASE III Plus, SuperCalc 4, Lotus 1-2-3, and PageMaker.

Master disks containing educational versions of Microsoft Works,
WordPerfect, WordStar, dBASE III Plus, and SuperCalé 4 are available
from Houghton Mifflin without charge to adopters of the manuals. These
disks may be duplicated for individual student use by instructors in accor-
dance with applicable license agreements.

For Lotus 1-2-3 and PageMaker, exercise disks rather than educational
versions of the program disks are available from Houghton Mifflin with-
out charge to adopters.

All manuals in the Software Solutions Series and their accompanying
disks are for use with IBM equipment except for PageMaker, which is only
for the Macintosh.

We wish to thank Microsoft Corporation, WordPerfect Corporation,
MicroPro International, Computer Associates, and Ashton-Tate for their
cooperation in helping to make this series available.
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USING WORDSTAR introduces the student to a well-known, powerful,
flexible, and widely used word-processing program. Students can use
WordStar Professional, Release 4.0 in word-processing classes, courses
that stress composition and writing, and business communications courses.

By teaching them how to create, save, edit, and print a document, this
manual provides students with a tool they can use throughout their edu-
cational carcer. It does so by encouraging the natural learning process so
that students avoid frustration and confusion. The manual’s logical design
allows students to master WordStar functions in small, easy steps. This
sharp focus permits students to develop an understanding of how the pro-
gram works and to issue commands confidently to achieve useful results—
all within a reasonable time frame.

Wordstar’s Educational Version provides a dictionary disk. Word-
Star checks the spelling in your document against two major dictionary
files: Main.Dct and Internal.Dct. The third file, Personal.Dct, allows you
to add words that are not in the main dictionary. For example, you can put
specialized words in your personal dictionary.

Pedagogical features that cnsure mastery of the basics in a short peri-
od of time are an integral part of cach chapter.

An introduction explains features covered in the chapter.
New terminology is presented at the beginning of each chapter.

Step-by-step instructions are followed by an illustrated example and
practice exercises that allow students to use cach feature in a hands-on en-
vironment.
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Every exercise step number is enclosed in a box, making it easy for students
to identify what they are to read and what they are to do.

Frequeht illustrations make it casy for students to check their work as
they go along, building their confidence and understanding and providing
positive reinforcement.

Special notes give students important shortcuts and reminders as well as
directions and explanations.

Each chapter ends with a summary of the concepts and commands present-
ed in the chapter; this encourages review and mastery of the basics.

Five appendixes make it easy for students to look up the information they
need to use the program: Appendix A provides a summary of WordStar
commands; Appendix B summarizes WordStar’s menus; Appendix C lists
the steps necessary for formatting a disk and copying a file to another
disk; Appendix D summarizes WordStar’s default conditions; and Appen-
dix E explains WordStar’s spcller.

The manual’s step-by-step instructions complement the classroom-
tested Read and Do approach to teaching. After reading a simple expla-
nation of a new concept and studying an example, students complete an ex-
ercise on the computer. This logical presentation means that students focus
on one feature at a time, are guided through an exercise in which they
practice using the feature under discussion, and complete the exercise on
their own—gaining confidence as they complete the performance of each
new feature. Clear hands-on instructions walk students through each new
element of the program, and illustrations showing correct screens or print-
ed output allow them to check their work as they go along.

Because this manual is designed to give new users basic competence in
using the program, it does not cover advanced and esoteric WordStar fea-
tures that are unlikely to be used by the majority of students. Ten text
chapters thoroughly cover the commands needed to create, save, edit, and
print a document. Students who wish to do so may experiment with other
features included on the disks but not discussed in the manual.

MicroPro has developed the Educational Version of WordStar Profes-
sional, Release 4.0 to introduce new users to the program’s capabilities
and to provide them with an opportunity for actual hands-on use in an ed-
ucational setting. WordStar Professional Educational Version comes on
two disks: (1) the Program Disk, which contains all program files, and (2)
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the Dictionary Disk. Master disks containing the Educational Version of
WordStar Professional, Relecase 4.0, which may be copied, are supplied to
instructors who adopt this manual. The program is preinstalled for IBM-
PC or 100 percent compatible computers using a dot matrix printer. Stu-
dents may, however, use the Install command to install their own printer.

The educational version of the software has been limited in the fol-
lowing ways:

1. At the bottom of each page, the Educational Version automatically
prints a footer that reads:

WordStar Professional, Rel 4 - Educational Version

2. WordStar Professional Educational Version does not automatically
print page numbers. The program will print page numbers when using
either a header or footer.

3. The actual file size in the Educational Version is limited to 10K. This
means that you might normally be able to work with and store approx-
imately five pages of full text on the educational version disk. More
when the pages are not completely full of text characters and multiple
formatting codes can be stored on the educational version disk.

4. The WordFinder thesaurus is not included on the disk.

5. WSCHANGE is not included. This utility allows you to change the
color selections for color monitors and make a variety of other attribute
adjustments in the standard WordStar Professional program.

To use this manual, you must have the following;:

A copy of the WordStar Professional master disks supplied to instructors
who adopt this manual

An IBM-PC or 100 percent compatible computer that uses double-sided
floppy disks

Two disk drives

At least 256K RAM (Random Access Memory)

MS or PC DOS 2.0 or higher

A standard monitor or an IBM Enhanced Color Display monitor
A color or black and white graphics printer

Formatted floppy disks for storing files and backing up program disks
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e Limited Use Software Agreement For The
Textbook Version

1.

WHAT THIS IS. This card contains the MicroPro International Cor-
poration®, (“MicroPro”) Limited Use Software License Agreement for
Educational Institutions (“Institution”) adopting the Textbook USING
WORDSTAR, which will govern Institution’s use of the MicroPro
Textbook Education Version of WordStar® Professional Release 4.0.

INSTITUTION THROUGH ITS AGENTS OR REPRESENTATIVES
AGREES TO THE TERMS OF THIS AGREEMENT BY THE ACT OF
OPENING THE SEALED PACKAGE THAT CONTAINS THE MAGNET-
IC MEDIUM OR MEDIA ON WHICH THE SOFTWARE IS RECORDED.
DO NOT OPEN THE SEALED PACKAGE WITHOUT FIRST READING,
UNDERSTANDING, AND AGREEING TO THE TERMS AND CONDI-
TIONS OF THIS AGREEMENT. INSTITUTION’S AGENTS OR REPRE-
SENTATIVES MAY RETURN THE SOFTWARE FOR A FULL REFUND
BEFORE OPENING THE SEALED PACKAGE.

2.

GRANT OF LICENSE. MicroPro hereby grants Institution, and
Institution hereby accepts, a limited license to use the enclosed disk(s)
(“Software”). Institution’s faculty and students may use this Software
only in conjunction with the adopted textbook, USING WORDSTAR.
Institution’s may make up to fifty (50) copies of Software for use by stu-
dents enrolled in courses where said textbook is being used and five (5)
backup or archival copies. For each copy so made, Institution must af-
fix a preprinted WordStar Educational Version Label which is includ-
ed with Software. If Institution desires to make more than fifty (50)
copies of Software, it must secure additional labels from the publisher
of USING WORDSTAR. Institution may not transfer or sublicense, ei-
ther temporarily or permanently, its right to use and reproduce the
Software under this Agreement without the prior written consent of
MicroPro.
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3. TERM. This Agreement is effective from the day Institution opens the
sealed package containing the magnetic medium or media on which
the Software is recorded and continues until Institution returns the
original magnetic media to MicroPro. Institution must also certify in
writing that it has destroyed any archival copies it may have record-
ed on any memory system or magnetic medium.

4. MICROPRO’S RIGHTS. Institution acknowledges that the Software is
the sole and exclusive property of MicroPro. By accepting this Agree-
ment, Institution does not become the owner of the Software, but Insti-
tution shall have the right to use and reproduce the software in accor-
dance with this Agreement. Institution agrees to use its best efforts
and take all reasonable steps to protect Software from unauthorized
use, illegal reproduction, or illicit distribution.

5. LIMITED WARRANTY. MicroPro warrants for a period of ninety (90)
days from the effective date of this Agreement that, under normal use,
the material of magnetic disk(s) will not prove defective and that the
program is properly recorded on the disk(s). If during the ninety day
period, a defect in the Software should appear, Institution may return
the Software to MicroPro for replacement without charge. Institu-
tion's sole right with respect to a defect in the Software is replacement
of the Software.

EXCEPT FOR THE LIMITED WARRANTY DESCRIBED IN THIS PARA-
GRAPH, THERE ARE NO WARRANTIES, EITHER EXPRESSED OR IM-
PLIED BY THIS AGREEMENT. THESE INCLUDE, BUT ARE NOT LIM-
ITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRAN-
TIES ARE EXPRESSLY DISCLAIMED.

6. LIABILITY. Institution agrees that regardless of the form of any claim
Institution may have, MicroPro's liability for any damages to Institu-
tion or to any other party shall not exceed $5000 (five thousand dol-
lars).

MICROPRO WILL NOT BE RESPONSIBLE FOR ANY DIRECT, INCI-
DENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM USE
OR REPRODUCTION OF THE SOFTWARE OR ARISING OUT OF ANY
BREACH OF THE WARRANTY, EVEN IF MICROPRO HAS BEEN AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGE.
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SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION
OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES,
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO
INSTITUTION. INSTITUTION MAY ALSO HAVE OTHER RIGHTS
THAT VARY FROM STATE TO STATE.

7.

TERMINATION OF AGREEMENT. If any of the terms and conditions
of this Agreement are broken, MicroPro has the right to terminate the
Agreement and demand that Institution return the Software to Micro-
Pro. At that time Institution must also certify in writing that it has
not retained any copies of the Software.

. GOVERNING LAW. This agreement is to be governed by, and inter-

preted in accordance with, the laws of the State of California and the
United States. Any terms or conditions of this Agreement found to be
unenforceable, illegal, or contrary to public policy in any jurisdiction
will be deleted, but will not affect the remaining terms and conditions
of the Agreement.

ENTIRE AGREEMENT. This Agreement constitutes the entire agree-
ment between Institution and MicroPro.



Learning About Your
IBM PC

Welcome to WordStar and word processing!
WordStar—Educational Version has many fea-
tures that allow you maximum flexibility in re-
vising, correcting, and expanding your written
communications.

So that you will be more efficient in using
WordStar, take a few minutes to become ac-
quainted with the IBM Personal Computer (IBM
PC). Refer to the IBM PC Guide to Operations
and the DOS manual, and to any other training
materials you have, for specific instructions on
its use.

Do not be intimidated by the computer. It is
simply a sophisticated tool that saves time and
improves your efficiency and productivity in
handling information. Before you begin, howev-
er, you should know that learning to use Word-
Star on your IBM PC involves paying attention
to detail as well as practicing.

This chapter acquaints you with the basic termi-
nology, the components of your computer sys-
tem, and your word-processing work flow.



s Terminology

Knowing some basic terms will help you understand the IBM PC and its
operation. Here are some of the terms.

Hardware means the physical parts of the computer.

Software means the programs that run on the computer. Programs are
sets of instructions. The program tells the computer what to do,
when to do it, and how to do it. In this case, the software is Word-
Star. WordStar tells the computer to do typing tasks. Other soft-
ware allows the computer to perform tasks such as accounting or
graphics.

Peripheral equipment is all the parts of the computer other than the
system unit—such as thg: keyboard, the monitor, and the printer.
Peripheral equipment is a category of hardware.

Commands are combinations of keystrokes you use to instruct the com-
puter to perform certain functions.

Functions are the operations performed by the computer.

The cursor is a blinking underscore that indicates your position on the
screen.

We will introduce additional terms as we go through this chapter.

s Basic Components of the IBM PC

The IBM PC has four basic components that work together as a complete
system. You should become familiar with the functions and capabilities
of these components. They are shown in Figure 1-1.

1. The keyboard
2. The monitor

3. The system unit
4. The printer
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Keyboard

Figure 1-1 Basic Components of the IBM PC

Keyboard

The IBM PC keyboard looks like the keyboard of a typewriter, except
that it has additional keys. You can see from Figure 1-2 that the central
portion of the keyboard has the standard display of letters and numbers.
To the left are ten special-function keys. To the right is a numeric keypad
that can be used for quick keyboarding of numbers or to move the cursor
around, as we shall see in Chapter 2.

' @
ﬂWNNﬂHMMMHHHﬂMHWM

HMMMM
epndaadddaddsmss
ullln

-1 T

| J\_ J
Function Typewriter keyboard Numeric
keys key pad

Figure 1-2 IBM PC Keyboard
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Let’s take a few moments to locate some of these keys. You will use
them often as you learn WordStar.

The special-function keys, or F-keys, of the IBM PC allow the system
to perform particular commands specific to the software. This eliminates
the need to press several keys to execute these commands. (These function
keys will be discussed in later chapters and are listed in Appendix A.)

NOTE: Keyboards may vary. Some keyboards have the F-keys locat-
ed above the top row of the typewriter keyboard. Always take
a careful look at the keyboard when you sit down at a computer
that is new to you.

To the right of the F-keys (on the left side of the typewriter key-
board) are some additional function keys whose commands do not change
from program to program. Take a few moments to locate the following
keys:

The Escape key, abbreviated Esc is used to break or cancel a function
or instruction. It cancels the last entry in a command. It may be used
to bypass options and screen displays.

The Tab key, labeled ( ‘:l ), is located under the Esc key. This key
moves the cursor to the next tab setting to the right (even though its
arrows point in both directions).

The Control key, abbreviated Ctrl, is used in combination with other
keys, to give the computer particular instructions. In this textbook
you will see the caret symbol (*) used for Ctrl. For example, Ctrl-K
and 7K both mean “Press the Control key, keep it down, then press
the K key.”

The Left Shift key located to the left of the spacebar is held down to
capitalize letters or to obtain special characters or symbols on the
right side of the keyboard. The shift key is labeled with an out-
lined upward arrow ( T).

The Alternate key, abbreviated Alt, is located under the left shift
key. In WordStar it is used to release the system when it “freezes”
or refuses to perform. Pressed together with the Control and Delete
keys, Ctrl-Alt-Del will reset the system. This procedure is men-
tioned in Chapter 2. Alt is also used with function keys to line and
draw boxes.

To the right of the regular keyboard are other function keys. Refer to
Figure 1-2 and locate these keys:
The Backspace key, labeled with an arrow («), moves the cursor
back one space and erases any character it goes over.



Basic Components of the IBM PC 5

The Enter or Return key, labeled with an arrow (), is used to:

a. Complete an instruction you have given to the computer.

b. Inserta “hard” carriage return in the text.

The Right Shift key, labcled with an outlined upward arrow ( T), is
located to the right of the question mark/diagonal key. This key is
held down to capitalize letters or to obtain special characters or
symbols on the left side of the keyboard.

The Caps Lock key is located to the right of the spacebar. It works
somewhat differently from a typewriter caps lock key. This key af-
fects only the alphabetic keys on the keyboard. For example, when
Caps Lock is on, you can type A1B2C3D4 without the specialized
characters above 1, 2, 3, and 4 (!, @, #, $) appearing. Also when
Caps Lock is on, the lowercase special symbols, suchas \ ,.;’[]- =,
are not affected. Press the Caps Lock key once to turn it on and then
press it again to turn it off.

There are also function keys located on the numeric keypad. Refer to
Figure 1-2 and locate these keys on your keyboard.

The Num Lock key is located in the top row of the numeric keypad.
When pressed on, Num Lock allows you to enter numbers using the nu-
meric keypad. Press again to turn the Num Lock key off. The numer-
ic keys then control the cursor, as described in Chapter 2.

The PrtSc key, labeled PrtSc/*, is used to “dump” to the printer
whatever appears on the screen. If you press the PrtSc key, an aste-
risk (*) appears on the screen. However, if you hold the left or right
shift key and press the PrtSc key, the text on the screen will be
dumped, that is printed if your printer is on.

The Insertion key, labeled 0/Ins, is located to the right of the Caps
Lock key. This key is used to insert new material to the already en-
tered text. It doesn’t remove or replace anything already in the text.
This key is automatically turned on when you start WordStar. To
turn off the Inscrtion key, press the 0/Ins key.

The Delete key, abbreviated Del, erases a character at the current
cursor position.

Monitor

The monitor, also called the screen display, or CRT (cathode ray tube),
looks like a television—as you can sce in Figure 1-1. The screen displays
the text you keyboard and displays instructions for you to follow.
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There are 24 vertical lines of 80 horizontal spaces each on the IBM PC
screen. However, only 22 lines are available for the text you keyboard,
because two lines are used for the status and ruler lines. There are at least
two knobs on a screen. One knob turns on the display and adjusts the screen
contrast. The other knob controls the screen brightness for eye comfort.
You will learn more about the screen and what appears on the screen in
Chapter 2.

System Unit

The system unit houses the central processing unit (CPU), the “brains”
of the computer. See Figure 1-3. The system unit also contains the memory
unit, one or more disk drives, the power supply, and other important
hardware.

CPU N
N
A N
JJN
[T [ NN
{ { { NN
|
oY |
ooooo
|5EEER) |
Keyboard [ ESSE% |
D’ﬁ‘:“:“:‘ Disk drive
emory

Figure 1-3 Central Processing Unit (CPU)

Memory

As its name implies, memory stores text or other information temporarily
until you decide to save (store) it onto a disk. Your IBM PC has at least
128K of memory. This means the computer provides storage space for stor-
ing at least 128,000 characters.
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Disk Drive

A disk drive holds the disks. It can save or write (record) information
onto a disk from memory and read (play) it back into memory.

Check to see if your unit has one or two drives. If you have two drives,
as in Figure 1-4, they are usually referred to as A and B, although no la-
bels appear. The first (left) drive is drive A; the second (right) drive is
drive B. Full-height drives are arranged side by side, A on the left and B
on the right, as shown here in Figure 1-4. Half-height drives (Figure 1-5)
are stacked with A on top of B.

Drive A

Drive B

Drive A Drive B
Figure 1-4 Full-Height Disk Drive Figure 1-5 Half-Height Disk Drive

The disk drives on the IBM PC are almost always double-sided, dou-
ble density. That is, the drives read information from and save it to both
sides of the disk.

The drive in use is known as the logged disk drive. For example, if
the computer is reading text from drive A, then drive A is the logged disk
drive. The disk inserted in that drive is the logged disk. The red light
on the disk drive comes on to show that the drive is saving or reading the
text.

Disks

The disk, also known as a diskette or floppy disk, is the magnetic record-
ing medium. A disk may be 3 1/2 or 5 1/4 inches square. You use double-
sided disks with the IBM PC. The 5 1/4-inch double-sided disks hold
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either 327,680 or 368,640 characters, depending on which version of disk
operating system (abbreviated as DOS) you use. Another way of saying
this is that double-sided disks can hold 320K or 360K. Figure 1-6 shows a
disk.

Labels

i] rj:] ] /Write-protect DE

notch g-—Write-protect

©
o<+————Index hole : o
U-———— Recording surface D
of disk

Disk envelope

Figure 1-6 Components of a Disk

The write protect notch allows information to be saved to the disk. If
the notch is covered with a write-protect tab, you cannot save to the disk,
but you can read from it. This prevents accidental erasure of information
from a disk. The drive uses the index hole to keep track of where the disk
is, that is, what part of the disk is being used.

Care of Disks

Disks must be handled with extreme care to prevent damage to the disks
and to the information stored on them. Follow these steps in caring for
your disks.

1. Keep disks in their protective envelopes when they are not being used.
2. Avoid bending disks.

3. Store disks away from extreme heat and away from magnetic paper-
clip holders, telephones, or any other pieces of equipment that contain
magnets.

4. Carefully insert disks into the disk drive to avoid jamming them;
make certain the label is toward you and the write-protect notch is at
the left.

5. NEVER insert a disk into the disk drive while turning the system on or
off, while printing, or while the drive is running.
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6. When naming the disk, cither place a label on the disk, then write on
the label using a felt-tipped pen; or write on the label before putting it
on the disk.

7. Do not touch the exposed recording surfaces.

Disk Operating System

The computer’s disk operating system (DOS) is a disk containing pro-
grams that manage the way in which information or text is entered or
moved from the disk. Many different DOS disks are available. The one
you choose will depend on the type of hardware and software you use.

Formatting a Disk

Before you can use a new disk, it must be formatted. Formatting a disk
means preparing the disk to record information. Formatting procedures
are given in Appendix C. You will learn how to format your disk in
Chapter 2.

Printer

The printer operates much like a typewriter, in that it prints text on pa-
per. However, a typewriter prints each character as you enter it, whereas
a printer is used only after the text has been entered. A printer has some
parts similar to a typewriter—a platen, a paper bail, and a paper re-
lease. There are different types of printers, for example, daisy-wheel,
dot-matrix, laser, and ink-jet.

s How Text Is Processed on the IBM PC

For a clear picture of how the IBM PC components work together as a sys-
tem and how text is processed, refer to Figure 1-7.

When text is entered on the keyboard, it is sent to the central process-
ing unit (CPU). Depending on the program instructions, the text can be dis-
played onscreen, stored in memory, saved onto a disk, printed by the
printer, or some combination of these.
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Printer

Keyboard

Figure 1-7 How Text Is Processed

To edit or make changes in the text you have keyboarded, you must
first ask the CPU to find the specific text you want to edit and display it
on the screen. The CPU checks to see if the text is currently in memory. If
the text is not in memory, the CPU checks to see if it is on the disk.

To print text stored on a disk, you must ask the CPU to find the text
and send it to the printer. The printer prints a hard copy (paper form) of
the text.

_Summary—

Hardware is the physical computer parts.

Software is the program which consists of the set of instructions to the com-
puter.

Programs instruct the computer what to do, when to do it, and how to do
it.

Peripheral equipment includes the keyboard, monitor, printer, and other at-
tachments.

Commands are combinations of keystrokes you use to instruct the computer
to perform certain functions.

Functions are the operations performed by the computer.

The cursor is a blinking underscore that indicates your position on the
screen.

The Esc key breaks or cancels a function or instruction.
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The Tab key indents text to the right.

The monitor is also known as the screen display or CRT.

The system unit houses the central processing unit (CPU).

The memory stores text temporarily until it is saved onto a disk.
Saving (or writing) means recording information onto a disk.
Reading means playing information from the disk into memory.
The logged disk drive is the disk drive in use.

DOS, the disk operating system, manages the way in which text is saved
onto and read from the disk; DOS also performs other tasks such as
printing and storing of files.

Formatting is preparing a new disk to record text.
Hard copy is a paper printout.



Learning the Basics

Many things can destroy, erase, or damage
disks, such as power surges, power failures,
faulty disk drives, and improper handling. As
mentioned in Chapter 1, the disks are fragile
and need special care. Before you begin using
any new program disks, such as DOS and Word-
Star, you should make at least one backup copy
of each program disk. Store the original in a
safe place and use the second copy as a work-
ing (or data) disk. The steps for backing up
disks are found in Appendix C.
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Before discussing the concepts in this chapter, let’s learn some basic terms.
Boot up means to activate the computer. The IBM PC must be started
with the DOS disk.

The prompt is shown as >, preceded by the letter of the logged drive,
on your screen. It alerts you that the computer has been booted and is
waiting for further instructions, in this case, to begin word processing
using WordStar.

Commands are combinations of keystrokes you use to instruct the com-
puter to perform certain functions.

Functions are operations performed by the computer.

Messages are sent from the computer and appear either at the top of
the screen or below the previous line. The messages usually request
additional information or describe errors you have made.

Additional terms are presented throughout this chapter.

s Booting Up Your IBM PC with DOS
Follow these steps to start up your IBM PC (using a two-disk system):

Hold the DOS disk so its long, exposed oval points away from you and the
label is on top, toward you.

Slide the disk carefully all the way into drive A; close the drive door.
See Figure 2-1.

@ Turn on the computer and screen.

a. The power switch on the computer is the red switch on the unit’s right
side. Flip it up to turn the unit on. See Figure 2-1. When the computer
is loading a disk, the in-use light comes on. Do not open a disk drive if
the in-use light is on.
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Figure 2-1 On-off Switch and In-use Light

b. If you have an IBM color monitor, turn it on with the top knob. (The
monochrome monitor comes on automatically.) Use the knobs to adjust
contrast and brightness. Turn the knobs clockwise to increase the
brightness and contrast; turn counterclockwise to decrease the bright-
ness and contrast. Proper adjustment on the monochrome monitor is
needed to see WordStar’s highlighting. A color monitor does not show
highlighting.

c. To restart the computer when it is already on, press and hold down in this
order: Ctrl, Alt, and Del. Then release all three keys.

Ctrl is to the left of the letter A.
Alt is to the left of the spacebar.
Del is in the bottom row of keys below the numeric keypad.

NOTE: Use the command Ctrl-Alt-Del ONLY to restart the system
when the power is already on. This is the only command that
requires you to press three keys at once. Do not use this com-
mand to restart the system when you are making changes to the
text, because the changes you make will not be saved.

Two screen messages may now appear on your screen requesting the current
date and the time of day. If you wish to skip these two screen messages,
just press the Return key each time to void them. The Return key (labeled
1) is below the Backspace key.

Give the current date and time of day.

NOTE: If you make a typing mistake, simply use the Backspace key to
position the cursor under the incorrect character, then type in
the correct character. The Backspace key (labeled «) is locat-
ed above the Return key.
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a. Use the month-day-year format, separating the numbers with dashes
or slashes. For the number 1, use the top-row number 1. NEVER use the
letter [ from the alphabetic keyboard for the number 1. If the current
date is March 15, 1987, enter the date as:

3/15/87 or 03/15/87 or 3-15-87 or (03-15-87
Press Return to enter the date.

b. Type the correct hour and minutes, separating the two with a colon.
The IBM PC uses the 24-hour clock. For example, 8:10 means 8:10 a.m.;
20:10 means 8:10 p.m. If the time is 7:30 p.m., you type

19:30
Press Return to enter the time.

A copyright notice (Figure 2-2) may appear on your screen if you are
using a floppy disk system. The message you see may vary from the one
shown in Figure 2-2, depending on what version of DOS you have. (The Xs
will appear as numbers.)

The IBM Personal Computer DOS
Version XXX (C) Copyright IBM Corp XXXX
A>_

Figure 2-2 Copyright Notice

Following the copyright notice, the screen will show the prompt A>. A>
means that disk drive A is the logged drive. The operating system uses
the screen prompt > to tell you the computer is ready to work for you and is
waiting for your instructions.

Notice the blinking underscore on the screen. This is the cursor. The
cursor marks your position on the screen. Further explanation about the
cursor is given later in this chapter.

Before you use a working disk, it must be formatted. Formatting
means that if a disk is new, it must be prepared to receive and save text.
If you wish to erase information on a used disk, you can reformat it. For-
matting procedures are given in Appendix C.

[5] Format your disk according to the steps in Appendix C.
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e \VordStar—Educational Version

This manual includes one WordStar—Educational Version disk. The Mi-
croPro Educational Division of MicroPro International Corporation
developed this disk for educational use only and has included only those
commands necessary for you to begin learning WordStar. The complete
version of WordStar contains several additional commands not included in
this educational version.

s Starting WordStar

4]

When A> appears, telling you that the operating system is waiting for
further instructions, you are ready to start WordStar.

To start WordStar from a floppy disk system, follow these steps (or fol-
low your instructor’s directions if you have a hard disk):

Remove the DOS disk from drive A; return it to its protective envelope.
Insert the WordStar disk into drive A.

Type the command WS. That is, type the letters W and S with no space or
punctuation. (Don’t worry about upper- or lowercase: both are read by the
computer.)

Press Return. Notice the WordStar copyright information on your screen.

WordStar Menus

WordStar provides explanations about its commands by displaying on-
screen summaries. These summaries are called menus. The menus explain
the various commands and identify which keys to strike to execute these
commands. You will use these menus a lot in the early learning stages.
However, as you gain skill and confidence in working with WordStar, you
may not need these menus and can usually bypass them.

Six major menus are included in WordStar. You should become famil-
iar with each of them as they are presented in these chapters. A sum-
mary of the menus is included in Appendix B. This chapter introduces the
Opening Menu and Edit Menu.
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Opening Menu

The first menu to appear on the screen after you have started WordStar is
the Opening Menu. This menu is shown in Figure 2-3. The Opening Menu
summarizes the WordStar commands that manage your documents.

4 M
OPENING MENU
D open a document L change logged drive/directory
N open a nondocument C protect a file
P print a file E rename a file
M merge print a file 0 copy a file
I index a document Y delete a file
T table of contents F turn directory off
X exit UordStar Esc shorthand
J help R run a DOS command
DIRECTORY Drive A: 14M free
.4k BOX .1k CHAPTER1.DOC .1k CHAPTERZ.DOC .1k CHAPTER3.DOC
3.5k DIARY.DOC 5.5k PRINT.TST 3.6k README .9k RULER.DOC
.bk SAMPLE1.DOC .4k SAMPLEZ.DOC .3k SAMPLE3.DOC .9k TABLE.DOC
5.5k TEXT.DOC 1.5k WSINDEX. XCL
. J

Figure 2-3 Opening Menu

Changing the Logged Disk Drive

The logged drive is the drive that WordStar will use to retrieve or store
data. When using WordStar on a floppy-disk system, one of the first tasks
you need to perform is to change the logged disk drive. This tells Word-
Star where to look for your files. At this point, your WordStar program
disk is in drive A. You can make drive B the logged disk drive by pressing
the letter L. This gives you more space to work and store information per-
manently for future use. The command for changing disk drives is located
on the right side of the Opening Menu.

Let’s change the logged disk drive from A to B by completing each step:

Be certain that your formatted disk (working disk) is in drive B. Remem-
ber that a new disk must be formatted. The formatting procedures are list-
ed in Appendix C.

Type the letter L with no punctuation. Wait. The screen in Figure 2-4 ap-
pears, describing the logged disk.
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The logged disk drive is uhere WordStar will get a document if you
do not specify a drive letter as you enter a document name.

The logged disk drive is currently: A:

You may also specify a directory path name. For example, if you
uanted to log onto the directory TESTDIR on drive C, you would

type C:\TESIDIR here.

Legal drives are: ABCDEFGHIJKLMNOPRBRSTUUUXYZ

What would you like the neu logged drive to be?

<1 done | Backspace or “H erase left | "X moue cursor to directory
~U cancel | Del erase H
DIRECTORY Drive A: 14M free "W scroll up *"Z scroll doum
.4k BOX .1k CHAPTER1.DOC .1k CHAPTERZ.DOC .1k CHAPTER3.DOC
3.5k DIARY.DOC 8.6k FIGZ2-3.SCR 5.5k PRINT.TST 3.6k README
.Sk RULER.DOC .bk SAMPLE1.DOC .4k SAMPLEZ2.DOC .3k SAMPLE3.DOC
.9k TABLE.DOC 5.5k TEXT.DOC 1.5k WSINDEX.XCL

J

Figure 2-4 L—Logged Disk Drive

Answer the prompt “What would you like the new logged drive to be?” by
typing B with no punctuation.

E Press Return.
Leave this information on your screen.

NOTE: To change the logged disk drive from B to A, you press the let-
ter L and enter A with no punctuation, then press Return.

Files

Documents or files on the computer are similar to the files in a file draw-
er. Documents, such as letters, reports, and memos, are kept in file folders
and stored in the proper filing cabinets according to their label names.
When you need a file, you usually request it or look for it by the name on
its label. Think of WordStar as an electronic filing cabinet and each disk
as a file drawer containing document files with labels or names.

An example of a file drawer containing documents is shown in Figure
2-5. The heading Directory is shown at the bottom of your screen. Locate
this heading.
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4 A
OPENING MENU |
D open a document L change logged drive/directory
N open a nondocument C protsct a file
P print a file E renane a file
M merge print a file 0 copy a file
I index a document Y delete a file
T table of contents F turn directory off
X exit UordStar Esc shorthand
J help R run a DOS commsand
DIRECTORY Drive B 145k free
.4k BOX .1k CHAPTER1.DOC .1k CHAPTERZ.DOC .1k CHAPTER3.DOC
3.5k DIARY.DOC 5.5k PRINT.TST 3.6k README .9k RULER.DOC
.6k SAMPLE1.DOC .4k SAMPLEZ.DOC .3k SAMPLE3.DOC .9k TABLE.DOC
5.5k TEXT.DOC 1.5k USINDEX. XCL
\_ J

Figure 2-5 The Directory

The directory shows the files on the logged drive in alphabetical or-
der, read from left to right. To the left of each file name is the number of
kilobytes the file takes up. One byte is the amount of storage required to
hold one character in computer memory or on disk. One kilobyte equals
1,024 bytes.

Because you have not opened any files, your directory is blank. As you
create documents, the names will be automatically listed in this
directory.

Before you type any text, you have to create a file by naming it.

Opening a Document

From the Opening Menu, locate D, Open a Document. This command al-
lows you either to open (recall) a previously recorded document or to
create a new one. After typing D to open a file, a new screen message ap-
pears and describes this command. Figure 2-6 shows the message you see
on your screen.

As in any filing system, the names of files should be appropriately se-
lected to maintain an efficient record of what you have on your disk.
WordStar will accept a file name only if it meets certain specifications.
Study the following example:

ANDERSON.LTR



Starting WordStar 21

N\

D WordStar Professional Release 4 Educational Uersion

Type the name of the document to create or change.
Include drive and directory if they are different from current.

The directory, if on, displays the names of existing files you may
change. To create a neu document, type a neuw name and press Enter.

Document to open?

<! done | Backspace or “H erase left | *X moue cursor to directory
“U cancel | Del erase

DIRECTORY Drive B 145k free

.4k BOX .1k CHAPTER1.DOC . 1k CHAPTERZ.DOC .1k CHAPTER3.DOC
3.5k DIARY.DOC 5.5k PRINT.TST 3.6k README .9k RULER.DOC

.6k SAMPLEL.DOC .4k SAMPLEZ.DOC .3k SAMPLE3.DOC .9k TABLE.DOC
5.5k TEXT.DOC 1.5k HSINDEX. XCL

Figure 2-6 D—Opening a Document

This file name consists of

1.

The filespec, which can be no longer than eight characters. ANDER-
SON is the filespec. The term filespec is short for file specification.

An optional name extension, LTR in this case. The name and the exten-
sion must be separated by a period. The extension supplies further
identification as needed. It must not exceed three characters.

In this manual we will capitalize all the file names. You need not do so.

Naming

a File

Follow these specifications when naming files.

1.

Choose a filespec with no more than eight characters (letters or num-
bers).

Choose an extension with no more than three characters (letters or
numbers). Use a period to separate the extension from the filespec.

Do not space within the file name or use a symbol such as an asterisk,
or a punctuation mark such as a question mark.

An example of a valid file name is JONES.LTR because the filespec

has no more than eight characters and the extension following the period
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has no more than three characters. An example of an invalid file name is
JONES.LTR#1 because the extension contains a symbol (#) and has five
characters. Another example of an invalid file name is JONES.LR 1 be-
cause the extension contains a space before the number 1. This file name
could be correctly written as JONES.L1 if you wished to number it. Then
you could number the letters in two digits if necessary.

After the file is named, the Opening Menu is replaced with the Edit
Menu. You will learn more about this menu later in this chapter.

Open a document by completing each step:
Type D (without punctuation). Wait for the screen prompt.

At the prompt “Document to open?” key in the file name PRAC (without
punctuation).

Press Return.
At the prompt “Can’t find that file. Create a new one (Y/N)?", press Y.

Continue with the next section.

Edit Menu

After you open and name a file, the second WordStar menu appears. It is
the Edit Menu; see Figure 2-7. On your screen, the Edit Menu is displayed,
along with a status line, ruler line, flag column, text area, and prompts for
ten special-function keys.

1. The status line appears on all menus. It tells you the following;:

Disk drive = Logged drive

File name = Current file’s name

Page of document = Page number you are on in the file
Line number = Line you are on on the page

Column = Position of the cursor within the line
Insert = Insert on/off

Align = Paragraph align on/off
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~
— EDIT MENLU
CURSOR SCROLL ERASE OTHER MENUS
“E up “U up “G char ~J help “0 onscreen format
~X doun ~Z down “T word ~I tab “K block & save
“S left “R up screen *Y line VU turn insert off “P print controls
“D right “C dowun " Del char “B align paragraph "0 quick functions
“A word left screen “U unerase "N split the line Esc shorthand
“F word right “L find/replace again
B T B I e S B R B S —R

2> 322>

DisplayfiCenter EChkRest@ChkUordfiDel BlkRHideBlk@oueBlkECopyBlklBeg BlkjlEnd Blk
jiHelp . %ZlUndo  glUndrliniBold SDelLineiDellordgAlign :Ruler :Sauve & %Done .- J
Figure 2-7 Edit Menu

The Edit Menu revicws the basic cursor-movement commands; scrol-
ling commands, which allow text entered to be moved up and down on
the screen; editing commands, such as those that erase characters,
words, or lines; formatting commands, such as those that set tabs or
align paragraphs; and commands for moving from one menu to another.
These commands will become familiar as you work through this
manual. ‘

The ruler line shows the location of margins and tab stops currently in
use. The ruler line changes as you change the position of margins and
tabs.

a. L marks the left margin.

b. Each exclamation point marks a tab stop.
¢. R marks the right margin.

WordStar allows a line of up to 65 spaces.

The Flag column displays symbols which represent functions you have
completed. An example is <, which means you have pressed the Re-
turn key to end a line or paragraph.

The text area is where you enter the text.

6. The prompts for ten IBM PC function keys refer to the ten special-

function keys at the left side or top of the IBM PC keyboard. These
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keys allow you to perform specific functions with fewer keystrokes
than the standard WordStar commands. The function keys are ex-
plained in Appendix A.

Don’t worry if these prompts appear confusing. You will become fa-
miliar with these menu parts as you go.

Your file is now open under the name of PRAC. Complete these steps to
type text:

Enter your name and address on the same line in the text area. Don’t wor-
ry if you make typographical errors—just ignore them for now. You will
learn how to correct them in Chapter 3.

Notice that the status line calls attention to the logged disk drive, the
file name, and the page (P), line (L), and column (C) you are on.

Save this document on your screen. Hold down the Ctrl key and press K;
release both, then press S ("KS). This procedure is explained in detail in
Chapter 3. :

Do not turn off the computer at this point.

NOTE: In later chapters, we will use the caret symbol (*) to represent
the Control key. The Control key is always held down while a
second key is pressed. Both keys are then released. Then, as
needed, one or more additional keys are pressed, one by one, to
complete the sequence.

Getting Help

2]

Help messages provide a serics of explanations about general features
and specific functions of WordStar. For example, the messages display
explanations about setting margins, tabs, and line spacing. You can get
help either from the Opening Menu (J) or from the Edit Menu (Ctr1-]). Fig-
ure 2-8 shows what the screen displays when a Help message is given.

To select a Help message from the Edit Menu, complete these steps:

Be certain the Edit Menu is on your screen, with your name and address in
the text area. '

While holding down the Ctrl, press ] to display the messages (*]).
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To get help with the Edit Menu aboue, press one of the keys that are
shoun to the left of each description in the menu at the top of the
screen. C(Remember that """ means you should use the control key.)

For a general explanation of the screen, press question mark (7).
For help with dot commands, press dot (.).
For help with saving your work, press “KD.

If you would like to change the help level, press *J again.

DisplayfiCenter hkRestfChkUordiDel BlkjjHideBlkjMoueBlkCopyBlkliBeg BlkjlEnd Blk
jlHelp %Undo  SlUndrlinilBold SPelLineiDellordfgAlign :Ruler s$Save & “Done
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EDIT MENLU
CURSOR SCROLL ERASE OTHER MENUS
“E up “d up “G char ~J help ~0 onscreen format
~X down ~Z down “T word I tab- “K block & save
“S left “R up screen Y line “VU turn insert off “P print controls
“D right ~C doun Del char "B align paragraph ”Q quick functions
“A word left screen “U unerase "N split the line Esc shorthand

J

Figure 2-8 Help Message

l_?_l For an explanation of the clements shown on the screen, press a question
mark (?). Figure 2-9 shows the screen message. Review all the screens.

E While holding down the Ctrl, press U; release.
@ While holding down the Ctrl, press K; release both, then type Q to aban-

don the practice file ("KQ).

Cursor Movement

Find the section heading Cursor on the WordStar Edit Menu. Read
through this list of cursor-control keys. You can move the cursor from one
position to another ecither by using the Ctrl key and one of the six alpha-
betic keys that make up the cursor diamond on your keyboard, or by using
one of the IBM PC keyboard’s arrow keys on the numeric keypad (cursor
keypad). You will be moving the cursor in the next practice exercise, so

study Figure 2-10.
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4 )

L—-¢ —r— ¢ t—— 9 —t —R
: Elements of your screen display
{C B:FILENAME.EXT ¢ {(——— Status line Filename, cursor positiom,
1 CURSOR : suitches, status information
i “E up : <{— Menu C(at Help Leuel 3
| X doun : < (List of available commands)
1 7S left :
{L—- 4 $——: {——— Ruler line Margins and tabs
H The quick broum : {—— Text Your typing appears here.

Press Esc for next screen or "U to leaue help

DisplayfiCenter QPChkRest@ChkUordfiDel Blk| HideBlk -ueBlk opyBlkliBeg BlkjlEnd Blk
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Figure 2-9 Help Message

Study these cursor moves:

To move the cursor: Cursor Diamond Cursor Keypad
One character left Ctrl-S «—
One word left Ctrl-A Ctrl «
One character right Ctrl-D -
One word right Ctrl-F Ctrl —»
One line down Ctrl-X \A
One line up Ctrl-E T

In using the cursor diamond, the relative location of the keys will
help you to remember the direction in which they move the cursor. For ex-
ample, E is the top key on the cursor diamond, and it is used to move the
cursor one line up.

To practice cursor moves, complete these steps:
From the Opening Menu, type D to open a new file named CURSOR.
Type Y to answer Yes to screcn prompt.

When typing in text, do not use Return to end lines except at the end of the
paragraph. As you type the paragraph, notice that the computer fills out
each line by adjusting the space between words. This leaves a straight
(justified) right margin.
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\ y/
)

Figure 2-10 Keys Controlling Cursor Movement

E Type the sample paragraph given here. Don’t worry about typing er-
rors.The cursor is a flashing underscore that indicates your position on the
page. The cursor guides you along a line while you key text, but it can also
be positioned under any character on a line so you can change the text. Re-
member that each time you move the cursor, the status line changes to
show you the current line number and cursor position in the line. [For now,
do not press Return.]

@ Watch your screen as you complete the following cursor commands:

Cursor Diamond Cursor Pad

Cursor Move WordStar IBM PC
Move one character left. Ctrl-S «
Move one word left. Ctrl-A Ctrl «
Move one line up. Ctrl-E T
Move one character right. Ctrl-D -
Move one word right. Ctrl-F Ctrl »
Move one line up. Ctrl-E T
Move one line down. Ctrl-X d
Move one line up. Ctrl-E T
Move one word left. Ctrl-A Ctrl «
Move one word right. Ctrl-F Ctrl -

@ Save this document by holding down Ctrl and pressing K; release both,
then press D (AKD). Saving a document is explained in Chapter 3.

Cancelling a Command

You may change your mind about executing a particular command or you
may press the wrong key. To cancel or interrupt any entered command,
hold down Ctrl and press U (*U).
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Exiting WordStar

(@ ][] W]

To exit WordStar, complete these steps:

If the Opening Menu is displayed on your screen, type X (for eXit). If a
document is displayed on your screen, hold down the Ctrl key and press K;
release both, then type X (*KX). Chapter 3 explains this procedure.

When the DOS prompt appears on the screen, take your disks out of the
drives.

Return the disks to their protective envelopes or file box.
Turn off the printer if it is on.

Turn off the system unit and (if you have one) the color monitor or follow
your instructor’s directions.

| Summary—

To boot a two-disk system:
1. Slide the DOS disk into drive A.

2. Turn on the computer (and screen if you have a color monitor) or use
Ctrl-Alt-Del to reboot the system if it is already on.

3. Respond to the date and time requests.
4. Remove the DOS disk from drive A.
5. Insert WordStar disk.

To enter WordStar:

1. Type: WS (without any punctuation).
2. Press Return.

To change the logged disk drive:

1. Insert a formatted working disk into the drive you wish to use as the
data drive.

2. Type the letter L without any punctuation.

3. Answer the prompt “What would you like the new logged drive to
be?” by typing the drive designator with no punctuation.

4. Press Return.



Summary 29

To open or create a document:

1. Type D (without any punctuation).
2. Type the file name.

3. Press Return.
4

. At the prompt “Can’t find that file. Create a new one (Y/N)?",
pressY.

The status line appears on all menus and tells you the logged disk drive,
the name of the file, and the position of the cursor (page, line, and column
number).

The Edit Menu helps you perform simple editing functions, such as moving
the cursor; deleting characters, words, or lines; and moving from one menu
to another.

The ruler line indicates the location of the margins and tab stops currently
in use.

The text area is where you enter text.

The Help messages explain general features and specific functions. To dis-
play Help messages from the Edit Menu, use Ctrl-]. To display a particu-
lar help explanation from the Edit Menu press Ctrl-] and the letter abbre-
viation or symbol for that function.

To move the cursor: WordStar IBM PC
One character to the left Ctrl-S «
One word to the left Ctrl-A Ctrle
One character to the right Ctrl-D -
One word to the right Ctrl-F Ctrl-
One line down Ctrl-X S

One line up Ctrl-E T
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To exit WordStar and turn off your system:

1.

If the Opening Menu is on the screen, press X to exit. If a file is on the
screen, press Ctrl-K,X to exit.

When the DOS prompt appears, remove the disks from the drives.

Return the disks to their protective envelopes or file box.

4. Turn off the printer, system unit, and monitor (as needed) or follow

your instructor’s directions.



Saving, Deleting,
Inserting, and Alignhing
Text

One of the benefits of word processing is the
basic document cycle. This involves opening
(creating) a file that can be saved, then re-
called, edited, and printed as often as needed.
Here is the basic document cycle:

1 Open a file.

2. Set (or reset) margins and tabs if necessary.
3. Type and save the text.

4. Make corrections and revisions if necessary.
5. Print the file.

This chapter shows how to save text; correct
basic typographical errors; and insert, delete
and align (format) text.



s Terminology

Before learning the concepts presented in this chapter, you should become
familiar with the following terminology.

Default conditions are WordStar’s preset format conditions. These
conditions have been programmed into the system. They save you time
when you start working with a document because you do not have to set
margins; line spacing, and other format conditions each time you begin.
You will learn how and when to turn off these default conditions in later
chapters. Some of the standard default conditions are explained here.

Word wrap. The IBM PC Return key is different from the Return key
on a typewriter. It is mainly used to signal the end of a paragraph, to in-
sert a blank line, and to complete commands. Unlike typewriters, word
processors carry (wrap) words around to the next line if they do not fit
within the right margin. With Word wrap, you can maintain a good key-
boarding rhythm longer because you do not have to press Return at the end
of each line.

Line justification. In a right-justified line, the right margin is made
as even as the left margin by adjusting the space between words. Justifica-
tion is used in most newspapers, magazines, books, and various kinds of re-
ports; uneven (unjustified) right margins are usually seen in letters and
memorandums.

Left and right margins. The side margins are set for a 65-character
line. The left margin is set at column 1, and the right margin is set at col-
umn 65 on your screen. The difference between columns 1 and 65 is called a
65-character line.

Tab stops are automatically set at five-space intervals, beginning at
column 6. A tab stop appears as an exclamation mark on your screen. Of
course, these marks do not print.

Insert-on. This means that you can insert text without erasing any-
thing already entered on the screen. The insert message appears in the
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upper-right corner in the status line at the top of your screen. Pressing the
Insertion key turns the Insert off if it is already on, and turns it on if it is
off. When Insert is on, any character that is inserted in front of text al-
ready entered moves that text to the right. When this feature is turned
off, the message disappears from the status line, and any characters you
enter replace the letter, number, or space that was in the same cursor posi-
tion.

Align. When you insert or delete text in a document, the length of
lines may change. If the line length does change, you will need to align
(reform) the text to make the lines fit within the margins again. The
align message appears in the upper-right corner in the status line at the
top of your screen. You will learn more about this feature later.

Paper length. This is set for a standard sheet of paper of 66 vertical
lines. Allowing for top and bottom margins, the system accommodates 55
typed lines.

Top and bottom margins. The top margin is set for three lines, and
the bottom margin is set for eight lines.

Line spacing. The page is set for single spacing. The spacing is set at
six lines per inch.

A summary of WordStar’s default conditions is given in Appendix D.

s Toggle Commands

Toggle commands are WordStar features that can be turned on or off. Ex-
amples are the commands that turn Word wrap, Insert, and Line justifica-
tion on and off. Other toggle commands will be introduced to you as you
learn to use WordStar.

s Hard and Soft Returns

It is important for you to distinguish between hard and soft returns. A
hard return occurs when the Return key is used to indicate the end of a
paragraph, line, or any other point where a permanent line is desired—
for example, between lines of a table. A hard return is shown on the screen
by the symbol < in the flag column.
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A soft return is only temporary. It occurs at the end of each line as
you enter text using Word wrap. When margins or tabs are changed in the
text, soft returns are automatically adjusted. A soft return is signaled in
the flag column by a blank space.

NOTE: To distinguish between hard and soft returns, REMEMBER a
hard return is made by the operator; a soft return is made auto-
matically by the system.

Flag Column

The flag column is the column on your screen at the right margin; it flags
(signals) returns and other appropriate information. Learn to watch the
flag column for special characters. A list of flag characters appears in
Appendix A. For now, learn the following flag characters:

Hard return: “<”

Soft return: “” (a blank space)

End of file (document): “/”

To understand the difference between hard and soft returns in the flag
column, follow these steps:

[1] Open a file named RETURNS.
@ Type the sample text given, noticing the difference between hard and soft

returns. Note that the length of lines on your screen will not match the
sample text.

@ Do not correct any typographical errors.
@ Watch the screen as you near the right margin. Remember that the sys-

tem automatically moves the cursor to the next line.

Just think about the typist who has to look at the draft
and touch type through the page. It is really quite
difficult for the typist to gain a comfortable typing
rhythm. Why? Because at the end of each line, the
typist has to listen for the bell, return the carriage, then
continue typing the next line. It is difficult for the typist
to maintain a typing rhythm longer than one line on
old-fashioned typewriters. [Return twice]
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A microcomputer senses the right-margin zone and
automatically returns the cursor to the next line. The
typist can now gain a comfortable keyboarding rhythm
that means faster typing.

EI Your file should remain on your screen. Check your screen.

s Saving a File

When you save information onto a disk, your computer copies this infor-
mation from its memory onto the disk. The disk drive’s red light comes on
while the information is being written (or stored) onto the disk.

Saving text onto a disk means you have to keyboard it only once. If
corrections or changes (editing) are needed, only these changes and correc-
tions have to be typed.

There are many ways information can be lost. Let’s take a look at sev-
eral situations that can occur.

1. If you turn the computer off at this point, without saving the previous-
ly typed paragraphs, these paragraphs will be gone when you turn the
computer on again.

2. If a power surge or a blackout occurs, the previously typed paragraphs
can be lost.

3. If the disk fills up, you have no space to save the file and you can lose
the previously typed paragraphs.

It is necessary to save the file both as you type information and when
you have completed it. Information is permanently stored only when you
save it.

One way to save a document is to use the IBM PC’s Ctrl and PrtSc keys.
This will save your document and take you to the screen where you make
print decisions. WordStar also offers different options for saving files.
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Block & Save Menu

For saving instructions, locate the words block & save under the section
heading Menus on your Edit Menu. It is marked with a caret (*) and the
letter K. (The * symbol signals you to use the Ctrl key with another key—

in this case K.)

To display the Block & Save Menu, follow these steps:

While holding down the Ctrl key, press K (*K). The menu should be dis-
played on your screen as shown in Figure 3-1.
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X save & exit UordStar
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Figure 3-1 Block & Save Menu

|Z| Leave the document on the screen and continue reading the next section.

Save Commands

Using the Block & Save Menu, locate the column Save on the left side of
the screen. WordStar offers four saving options. They are

AKS = Save & resume edit
(F9)

This command saves text that has just
been entered or edited, then allows you
to resume editing where you left off.
You have safely stored the text, but you
have not left the file.
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AKD = Save document This command is used when you have
(F10) completed editing and are ready to
save it permanently. After saving the
file, this command takes you back to
the Opening Menu.

AKX = Save & exit WordStar This command saves the file and exits
WordStar, taking you back to DOS.

AKQ = Quit without saving This command quits the file without
saving any current changes and takes
you back to the Opening Menu. If the
file has been previously saved, the file
is still saved, with no changes; if the
file has never been saved, it is aban-
doned. The prompt appears “Modifica-
tions have been made. Are you sure you
want to abandon (Y/N)?”

NOTE: 1. When exiting WordStar to DOS, the DOS prompt appears
on your screen. If you wish to start WordStar again at this
point, type WS and press Return.

2. When abandoning any revisions, a message appears on your
screen to confirm that you are abandoning the edited version.
The Opening Menu returns to your screen after you answer the
prompt.

@ To save your document named RETURNS, type D. The Opening Menu
should be displayed on your screen.

messmmemmm Text Editing

One of the important skills you have to develop is the ability to edit text.
Text editing on a computer involves proofreading, correcting, and revising
previously stored text. Text-editing is easy once you acquire a basic under-
standing of cursor movements, deletion, and insertion. With just these
three features, you can efficiently edit any document.
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mensnssssmm Deletion

Deletion is the process of removing characters, words, sentences, or para-
graphs from your document. You can delete a character or word to the
right or left of the cursor position, or you can delete a line or any text from
the middle to the end of a line.

Deleting Single Characters

[N][B]

To delete one character or space at a time:
1. Position the cursor on the unwanted character.

2. Press Ctrl-G or Del (Delete). Or, use Backspace to move the cursor one
space to the left and erase the character.

To practice the character deletion commands, follow these steps:
From the Opening Menu, open a file named ERRORS.

Type the sample text that follows. If you make any keyboarding errors,
ignore them! Note that the lengths of lines on your screen will not match
the sample text.

WordStars is a new dimensions in keyboarding with ease,
speed, and convenicnces. Now you can make many
last-minute improvements to your documents, the kind
that you wouldn’t usually make because you haven’t the
time to retype. [Return twice]

What a dream! You can forget poor erasures!

Make these deletions.

a. Delete the s from WordStars.

b. Delete the last s from dimensions.
c. Delete the s from conveniences.

Save and resume by pressing F9; or hold down Ctrl and press K,
release both, then press S.



Deletion 39

(5] Keep this file on your screen for the next practice exercise.

Deleting a Word

The following command is used to delete a word to the right of the cursor:
1. Position the cursor under the first character of the unwanted word.
2. Press the special-function key F6 or Ctrl-T.

NOTE: Ctrl-T (F6) deletes one word at a time, including the space that
follows the word.

To practice word-deletion commands, follow these steps:
[_T_l The file named ERRORS should be displayed on your screen.
IZ] Delete your from the third line.
@ Delete poor from the second paragraph.

<

E Save—hold down Ctrl and press K; release both, then press D. Or press
F10.

Deleting a Line

The following command deletes a line of text or a blank line:
1. Position the cursor anywhere on the unwanted line.
2. Press F5 or Ctrl-Y.
To delete a line, follow these steps:
E' From the Opening Menu, open a file named EDIT.
Iz] Type the sample text given, single-spaced. Ignore any keyboarding errors.

Delete is a function you should review and remember as
you edit text. [Return twice]

Delete commands are used frequently when you need to
correct errors that are found after you have keyboarded a
document. You must first remember to position the cursor
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under the character, word, or line you don’t want. Second,
you will need to press the control and the corresponding
WordStar delete commands.

[3] Save and resume editing by pressing F9 or holding down Ctrl and pressing
K, releasing both, then pressing S.

[4] Make the following corrections:
a. Delete the two lines of the first paragraph.
b. Delete the blank space after the first paragraph.

c. Delete a document at the end of the first sentence in the second para-
graph. Delete the space before the period at the end of the sentence.

d. Delete first from the second sentence.
e. Delete control and the from the last sentence.

@ Save—press F10 or hold down Ctrl and press K; release both, then press
D.

To delete a sentence, follow these steps:

1. Position the cursor at the beginning of the unwanted sentence.

2. Press Ctrl-Q,T and type a period as the character.

To delete a paragraph, complete these steps:

1. Position the cursor at the beginning of the unwanted paragraph.
2. Press Ctrl-Q,T and press Return for the character.

memesmsmmm Aligning Paragraphs

The paragraph align feature adjusts lines that have become uneven be-
cause of the text-editing additions and deletions. For example, when text
is inserted in a line, it pushes the remainder of the line outside the right
margin. After editing is complete, you must align (reformat) the text by
using the Align command.

Here is what you should expect when aligning paragraphs.

1. Text will be reformed according to your format conditions. This means
that the line endings will be aligned according to the set margins.
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2. Text will be aligned starting at the line where the cursor is positioned
and stopping at the first hard return.

To align a paragraph, follow these steps:
From the Opening Menu, open the file named ERRORS.
The cursor will be positioned on the first line of the first paragraph.

Hold down Ctrl and press B. Watch your screen as the text is aligned.

[&] [@] [M] [=]

To save, press F10 or Ctrl-K; release both, then type D.

Hyphen-help

Hyphen-help is a WordStar feature that becomes particularly important
as you align paragraphs. As a paragraph is reformed, WordStar scans the
text, looking for words that break at the end of a line. When it finds one,
the cursor stops under the word. The hyphen-help feature offers a Yes/
No choice at each possible hyphenation.

The following message appcears:

“To hyphenate, press—. Before pressing—, you may move
the cursor; AS = cursor left. AD = cursor right.”

Respond to the message either by pressing the hyphen key to hyphenate
or by pressing Ctrl-B to continue reforming the paragraph. Before pressing
the hyphen key to hyphenate, you may need to move the cursor first.

NOTE: 1. You cannot type a hyphen outside the right margin, that is,
column 65.

2. Do not assume that the point where the cursor stops is the
correct hyphenation. If in doubt, check a dictionary. To move
the cursor to the correct position, press Ctrl-S or Ctrl-D (or the
IBM PC arrow keys), then press the hyphen key.

The hyphen-help feature is a toggle command. In some documents,
you may not want any words to appear hyphenated at the end of lines, so
leave Hyphen-help off. To turn Hyphen-help on, press Ctrl-O (for On-
screen); release, then press H (for Hyphenation). To turn Hyphen-help
off, press Ctrl-O; release, then type H.
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Hard and Soft Hyphens

Be aware that there are hard and soft hyphens. A hard hyphen is en-
tered when you press the hyphen key. Hard hyphens will print, there-
fore, they must be removed if aligning puts them in the wrong place A
soft hyphen is printed only when it’s at the end of a line.

e Insertion

The insert feature is a default condition. You can insert everything from a
single character to entire pages between any two'characters, words, or sen-
tences. When you insert new text, the old text is moved (not replaced) to
make room for the insertion. The word Insert appears on the status line
when the insert feature is on.

Insert remains on until you turn it off. When you turn off Insert, the
messages disappear from the status line and any new text you insert will
replace old text. To turn Insert on and off, press Ins (which is the IBM PC’s
standard way of 1nsertmg) or press Ctrl-V (the standard WordStar com-
mand).

Once you have found the place where you want to insert text, there is
no difference between inserting a character, a word, a sentence, or even a
paragraph. When Insert is on, the following keys have different effects.

Return adds blank lines to alrcady entered .text; these lines are shown by
hard returns in the flag column.

Tab moves the text to the right of the cursor to the next tab stop. You will
use the tab in Chapter 5.

Spdcebar adds hard spaces at the cursor position.

Cirl-N splits the line without moving the cursor. Any text to the right of
the cursor will move down one line.

To practice turning on and off the insert feature, follow these steps:
Open a file named INSERT. Type this information single-spaced.

Margie LaVerne Tunnell [Press Return once]
2204 Avenue K [Press Return oncel
Orange, Texas 75030
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@ Move the cursor back to the beginning of line 1. With Insert on, type Mrs.
and a space. Notice that the inserted information is correctly placed be-
fore Margie.

Mrs. Margie LaVerne Tunnell
2204 Avenue K
Orange, Texas 75030

@ Now turn off Insert, type Mrs. with no space after it. You can see that
Mrs. replaces Marg, as shown here.

Mrs. Mrs.ie LaVerne Tunnell
2204 Avenue K
Orange, Texas 75030

El:l Leave the cursor where it is, turn on Insert, and press Return. A line has
been added.

Mrs. Mrs.

ie LaVerne Tunnell
2204 Avenue K
Orange, Texas 75030

@ Leave Insert on, position the cursor at the beginning of the third line, and
press Tab ( — ). The line is indented.

Mrs. Mrs.

ie LaVerne Tunnell
2204 Avenue K

Orange, Texas 75030
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@ Position the cursor after the comma following Orange, turn off Insert, and
press Tab twice. This time, the cursor simply moves over to the right,
without indenting the rest of the line.

Mrs. Mrs.

ie LaVerne Tunnell
2204 Avenue K

Orange, Texas 75030

Abandon the file by holding down Ctrl and pressing K; release both, then
press Q.

—Summary—

Default conditions are preset format conditions. They include Word wrap,
Line justification, Left and right margins, a five-space Tab grid, Insert,
Paragraph align, Paper length, and Top and bottom margins. A list of
default conditions is given in Appendix D.

The flag column shows hard and soft returns and indicates the end of a
file.

The Ctrl-K command displays the Block & Save Menu.
The four saving options shown on the Block & Save Menu are
S: Save & resume edit (special-function key F9)
D: Save document (special-function key F10)
X: Save and exit WordStar
Q: Quit without saving
The deletion commands presented in this chapter are
AG or Del: Delete a character or space at the cursor
AT or F6: Delete a word to the right of the cursor
AY or F5: Delete a line
AQT, period: Delete a sentence

AQT, Return: Delete a paragraph
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The command Ctrl-B aligns a paragraph after corrections or other changes
have been made.

The toggle command for insertion is Ctrl-V (WordStar) or Ins (IBM PC).



Moving the Cursor,
Scrolling Text, and
Printing

The advantage of handling corrections and
other changes and revisions In text Is probably
the main reason word processing on the
computer has widely replaced the traditional
typewriter.  With WordStar, edited text can be
revised faster and more reliably than on any
typewriter. For this reason, it Is important for
you to understand the functions and commands
presented in this chapter.

Ay
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In this chapter, you will learn how to move the cursor farther and faster
by using Ctrl-Q and one of the cursor-movement keys. (Q is the Quick
key.) When you press Ctrl-Q, the Quick Menu appears, as shown in Figure

4-1.
D B:PRAC PB1 1LA1 CO1 Insert Align
QUICK MENU
CURSOR FIND OTHER SPELL

E upper left P previous F find text U align paragraphs L check rest
X louer right U last find A find/replace M math 0 repeat N check word

S left side B beg block G char forward ERASE 0 enter word
D right side K end block H char back Y line to right SCROLL

R beg doc B8-9 marker I find page Del line to left W up, repeat
C end doc 7?7 char count Cor lined T to character Z doum

L—t— 4y}
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Figure 4-1 Quick Menu

The Quick Menu also displays other commands, including some Erase com-
mands. o

Deleting Text to the Right

Combining Ctrl-Q with Y is a quick method for deleting all text to the
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right of the cursor up to the end of that line. This cursor command does not
delete soft returns.

To delete a partial line of text up to the right margin, study these
steps:

1. Move the cursor to the left of the unwanted text.

2. Press Ctrl, then Q; release both, then press Y.

Deleting Text to the Left

][]

(&[]

Combining Ctrl-Q and Del (Delete key) will remove text from the cursor
position to the left side of the current line. The remainder of that line of
text moves to the left margin.

To delete a partial line of text to the left, study these steps:
1. Move the cursor to the right of the text to be deleted.
2. Press Ctrl-Q; release, then press Del.

NOTE: This command does not delete the character in the cursor posi-
tion.

To practice these quick deletion commands, follow these steps:
From the Opening Menu, open a file named QUICK.

Type the following sample text, single-spaced. Note that the lengths of
lines on your screen will not match the sample text.

Two of the delete commands appearing on the Edit Menu
are Ctrl-Y and Del. When combined with the Quick
Menu, the commands can delete text to the right or left of
the cursor. The Ctrl-Q,Y command deletes text to the
right of the cursor to the end of the current line. The Ctrl-
Q,Del command deletes text to the left of the cursor, up to
the left margin of that line. Using Ctrl-Q and Y or Del is
a quick way to dclete text.

Press F9 or press Ctrl-K; release, then type S to save and resume.

Move the cursor to the beginning of the paragraph and delete the first sen-
tence. Now with Insert on retype the sentence. (Don’t worry! WordStar will
make space for the retyped text.)
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Move the cursor to the last sentence and delete the entire sentence using
Ctrl-Q,Y. Retype the sentence.

CINC]

Move the cursor to the fourth line. Delete the words of the current line at
the end of the third sentence. Retype these words.

[~]

Move the cursor to the beginning of the file. Press Ctrl-B to align the par-
agraph. .

Press F10 or Ctrl-K,D to save the file and return to the Opening Menu.

e Quick C-ursor-Movement Commands

Combining Ctrl and Q with one of the cursor keys moves the cursor much
farther and faster. Compare them with the commands you learned in
Chapter 2. Both are summarized here.

Cursor Movement WordStar IBM PC
To move the cursor down:
one line AX d
to last onscreen line AQX End
To move the cursor up:
one line AE T
to column 1 in first
onscreen line QE Home
To move the cursor left:
one character AS «
to the first character
of the previous word AA A
in one quick move
to column 1 of the current line QS AQS
To move the cursor right:
one character . AD” -
to the first character in
the next word AF Ao
in one quick move to the
right of the current line QD QD
To move the cursor to the
~ beginning of a file AQR AHome
To move the cursor to the
end of a file QC AEnd
NOTE: To interrupt a Ctrl-Q command before entering the second cur-

sor-movement key, press Esc.
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masssssmmn Scrolling

To explain scrolling, let’s compare keyboarding a document on a typewrit-
er and on a word processor. When you keyboard a document on a typewrit-
er, you work with only one page at a time. This means you can read one
page at a time to see if you should make any corrections or changes. With
a word processor, on the other hand, you can work with the entire docu-
ment, no matter how many pages you have keyboarded. You can view an
entire document on your screen by moving lines, paragraphs, or even sever-
al pages up and down, to the left, or to the right.

Viewing Text at the Bottom of the Screen

To view text at the bottom of the screen, study these steps.

Press Ctrl-Z Scrolls down one line.
Press Ctrl- Q,Z Scrolls down, moving the
screen display down
continuously.
Press Ctrl-PgDn (on the cursor keypad) Scrolls down one screen.
or Ctrl-C

Viewing Text at the Top of the Screen

[ =]

To view text at the top of the screen, study these steps.
Press Ctrl-W Scrolls up one line.

Press Ctrl- QW Continuous scrolling line- by-
line to the beginning of file.

Press PgUp (on the cursor keypad)  Scrolls up one screen to previous

or Ctrl-R screen.
NOTE: 1. To scroll text continuously, press Ctrl-Q and W (up) or Z
(down).

2. To stop continuous scrolling, use the spacebar.

To practice the different cursor-movement and scrolling commands, com-
plete these steps:

From the Opening Menu, open a file named PROJECT.

Type the following sample text, single-spaced. Ignore typographical er-
rors.
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Thank you for taking your time to see our staff last
Wednesday and for letting us know more of your ideas
about our new project. It was interesting to learn the
viewpoint of somcone with extensive business and
teaching experience. [Return twice]

It does seem that your approach to getting our project off
the ground would be something less than compatible with
ours. At this point in our first stage, it is difficult for me
to see how our project team might work together
successfully using your proposal. There are other project
teams forming concerning the new products for this year.
[Return twice]

You might want to contact Harry Sloan, director of
marketing, to present your proposal. I am sure you will
have no difficulty in locating a project leader who will
take an interest in your well-organized and defined
proposal. [Return twice]

Thank you again for taking an interest at this time in our
particular project. [Return]

[3] Save the file and resume editing by pressing F9 or Ctrl-K,S.
(4] Complete these moves.

a. Move the cursor up to the top of the screen.

s

Move the cursor down to the bottom of the screen.
Move the cursor up two lines.
. Move the cursor to the beginning of the line in one quick move.

Move the cursor to the beginning of the file.

- o a 0

Move the cursor down two or three lines, one line at a time.

Move the cursor several words to the right, one word at a time.

5 @

. Move the cursor up several lines.

e

Move the cursor back to the beginning of the line, several words at a
time.
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j. Move the cursor down several lines.

k. Practice scrolling several lines of text at the top of the screen; then
scroll lines of text from the bottom.

1. Quit without saving the document by pressing Ctrl-K,Q.

s Printing

Before learning how to print a file, let’s review the stages your files have
been going through.

1. The document is first created onscreen; it exists in only the computer’s
memory.

2. Then it is saved onto a disk. You know this process is happening be-
cause the disk drive’s red light comes on.

Now you are ready to print a file from the disk. You are already fa-
miliar with saving files with the F10 or Ctrl-K,D command. Once the
Save command is given, the file can be printed. The Opening Menu lists
the print function represented by P.

To Start Printing

2]

] (]

To start printing, follow these steps:

Be certain that the printer is connected to your computer and that the
printer is plugged in and loaded with a ribbon.

a. Turn on the printer.
b. Be certain paper has been inserted correctly.
From the Opening Menu, type P.

At the screen prompt “Document to print?”, type the document name RE-
TURNS.

NOTE: Be certain to spell the file name correctly, exactly as it ap-
pears in the disk’s directory. If you make a mistake in entering
the file name, use the Backspace key to remove incorrect let-
ters. Or instead of typing the file name, use the cursor to point
to the existing file.

Press Esc. Printing begins and the Opening Menu appears after printing is
completed.
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On this educational version of WordStar, the following line will be
printed at the bottom of the page:

WordStar Professional Release 4 Educational Version

To Stop Printing
To stop printing, follow these steps:

E From the Opening Menu, press P to display the Printing screen (Figure 4-
2).

2] Type the document name PROJECT and press Esc.

[3] Assoonas printing begins, press P again to cause the printer to display the
Print commands. Immediately press P to pause the printer.

[4] Watch the screen and then respond to the prompt with an appropriate
command.

4 )

I PRINTING
" P pause “U cancel printing ||

C continue after pausing F print at full speed
B print from background

- %
Figure 4-2 Printing Screen

The Print commands are explained here.
P: Pauses printing temporarily.

C: Continues printing after pause.
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B: Starts background printing, returning you to editing or to the Open-
ing Menu depending on where you were before the Printing screen ap-
peared. Background printing allows you to continue with what you
were doing before you started printing.

AU: Cancels printing completely and returns you to editing or to the
Opening Menu depending on where you were before the Printing
screen appeared.

F: Starts full-speed printing if you have used WSCHANGE to slow
printer speed. (WSCHANGE is a program that allows you to
change a number of settings.)

Type Ctrl-U to cancel printing.

NOTE: Printing may not stop immediately on some printers.

_Summary—

The basm cursor-movement commands are given in the Edit Menu. Ctrl-Q
dlsplays the Quick Menu. The Quick Menu commands use the Ctrl-Q pre-
fix and include Cursor, Find, Erase, and other commands.

. WordStar IBM
To move the cursor down:

one line X 2
to ldst onscreen line AQX End
To move the cursor up:
one line AE T
~ to column 1 in first onscreen line AQE Home
To move the cursor left:
one character S «
to the first character of the
previous word 4.\ AN
in one quick move to column 1 of the
current line QS QS
To move the cursor right:
one character AD -
to the first character in
the next word AP Ao

in one quick move to the right end of
the current line QD AQD
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To move the cursor to the beginning of the file ~ QR AHome

To move the cursor to the end of the file QC AEnd
To view text at the bottom of the screen:
NZ. Scrolls down one line.
NQZ Scrolls down, moving the screen
display down continuously.
APgDn
orC Scrolls down one screen.

To view text at the top of the screen:

W v Scrolls up one line.
AQW Continuous scrolling line by line
to the beginning of file.
PgUp
orR Scrolls up one screen

To stop continuous scrolling, press any key.

To print:

1.
2.
3.
4.

Prepare the printer.
Type P.
Enter the name of the file to print.

Press Esc.

To stop printing;:

1.
2.

While printing is in progress, press P to display Print commands.

Press P again to pause the printer.

3. Press Ctrl-U to cancel printing.



Formatting

In the last two chapters, you have used Word-
Star’'s default conditions, practiced basic edit-
ing functions, and printed text. In this chapter,
we will present additional functions, which in-
clude changing line spacing, unjustifying text,
centering text, setting tab locations, and chang-
ing margins.



s Onscreen Formatting

Formatting includes conditions that affect the text appearance such as
line length and spacing, margins and tabs, centering, and justification. In
Chapter 3 you learned about WordStar’s default conditions for Line le-
ngth, Line justification, Word-wrap, and Insertion. One way to change
these default conditions is to use WordStar’s onscreen formatting. The
format commands are shown on the Onscreen Format Menu. The commands
are in effect only while the document is displayed onscreen. The onscreen
format can be printed out but not saved in the file.

With a document on y’Our,scfeen, you can display the Onscreen Format
Menu by pressing Ctrl-O. The Onscreen Format Menu is shown in Figure 5-1.

turn ruler off

omHXTr

ruler to text

ONSCREEN FORMAT MENU
MARGINS TYPING . DISPLAY
set left U turn word urap off D turn print controls off
set right J turn right Jjustify off H turn hyphen help on
release E enter soft hyphen P turn previeu on

G temporary indent

ruler from text S set line spacing

C center line

B turn soft space dots on
TABS

I set tab stop N clear

o

L— t ? 4

N

DisplayfiCenter hkRest hlior' Del BlkjHideBlkMoueBlkCopyBlklBeg BlkjlEnd Blk
biHelp  ZUndo  &UndrlingBold SDelLineiDellordgAlign :Ruler s$RSave & ‘Done

t——t—t

2222332320332

Figure 5-1 Onscreen Format Menu
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s Dot Commands

Dot commands are format commands you insert into a document before
printing it out. Unlike the commands from the Onscreen Format Menu,
these commands become a permanent part of the file. They can be used for
onscreen formatting and merging as well. Dot commands will be intro-
duced throughout the remaining chapters.

An example of a dot command is .LS, which represents line spacing.
There are some rules common to all dot commands. A dotcommand

1. Must be entered in column 1. If it is entered anywhere else, WordStar
treats it as part of the text, thus losing its intended effect.

Must be entered on a blank line.
Must have at least one space after the dot command.

Must have a dot and at least a two-letter code.

N

May require additional information after the dot (.) and two-letter
code.

When the dot is entered in column 1, a question mark appears in the
flag column. This question mark signals you to complete the dot command.

To obtain information on dot commands, use the Help Menu and press
Ctrl-], and then a dot (.). After the dot command has been placed in the
text, it may be eliminated simply by backspacing or by deleting the line.

s Selecting Line Spacing

Some of the default conditions explained in Chapter 4 include Word
wrap, Justification, Left and right margins, Insert, and Paper length. An-
other default condition is Line spacing. Line spacing is the amount of
space between lines of text. For example,

Desired spacing: Text prints on every: Blank lines between
text will be:

1 (Single) Line None

2 (Double) Second line One

3 (Triple) Third line Two

WordStar’s default condition is single spacing. Different documents
may require different line spacing. Therefore, depending on the line-
spacing requirements, you may need to change the default single spacing to
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double spacing or even triple spacing. Line spacing can be changed for the
entire document or only for shorter passages within the text. You can use
either Ctrl-O,S or the .LS dot command to change the line spacing. The
Ctrl-O,S command is kept with the document only during editing. The .LS
dot command allows you to save the line spacing selection with your docu-
ment.

Once the default is changed, the line-spacing notation will appear at
the right on the status line. To change the line spacing back to the default
condition (single spacing) within a document, you must re-enter Ctrl-O,S
and 1 (for single spacing).

NOTE: 1. If you have alrcady entered text and then change the line
spacing, you will not see the text changed on your screen until
you have realigned each paragraph using Ctrl-B.

2. Should you want to cancel the command after entering Ctrl-
O, press Esc.

To change line spacing, complete these steps:
Open a file named SPACING.
Press Ctrl-O;—release, then type S.

Answer the prompt “Enter new spacing.” by typing 2 to set the new line
spacing.

Press Return.

Enter the following sample text.

It is easy to control the depth of the line spacing of text on
a word processor. In a report, you may have some
paragraphs double-spaced while other paragraphs may
be single-spaced for special emphasis. To change the line
spacing, press Ctrl-O,S.

@ Press F10 or Ctrl-K,D to save the document.
Print a copy.

To save the line spacing selection with the document, follow these steps:
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E Open the file named SPACING.

@ Press Ctrl-N to insecrt a blank line.

[3] Type .LS, space once, and type 2 (to save the spacing selection). Press return.
@ Press F10 or Ctrl-K,D to save the document.

s Justifying Texf

Books and newspapers are set with justified left and right margins; busi-
ness correspondence is usually typed with unjustified right margins, called
ragged right margins. As mentioned in Chapter 3, justification means
that spaces are inserted between words to make the right margin even.
The default condition for justification is on. You can use Ctrl-O,] to turn
Justification off while you are working on a document. Whichever setting
you choose, it remains in effect until you exit the file you are editing.

NOTE: 1. You can always tell whether Justification is on or off by
looking at the Onscreen Format Menu under the heading, Typ-
ing. You will see “] turn right justify (off)."

2. If you have already entered your text and then turn off Justi-
fication, the change will not be shown until after you have rea-
ligned the paragraphs using Ctrl-B.

To turn off Justification, complete these steps:
II] Open a file named JUST.
[Zl Press Ctrl-O,].
(3] Change the line spacing from single to double (Ctrl-O,S,2).
@ Enter the following sample text, double-spaced.

Justification is a default condition on WordStar. In other
words, it is turned on automatically. On other word
processors, you may have to turn on this feature. If you
type a business letter using WordStar, turn the
justification mode off. You may want to justify the right
margin on reports, but you would not want to use
Justification when entering data for tables. If you use the
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justification mode for tables, the data would not necessari-
ly line up under column headings.

@ Press F10 or Ctrl-K,D to save the file.

@ Print one copy.

NOTE: 1. To print this unjustified document with a justified right
margin, you must turn on Justification and use the Realign (or
Reform) command, Ctrl-B.

2. You can also enter the .OJ on (off) dot command to permanent-
ly set Justification on (or off) within a document.

s Centering Text

When text is centered horizontally on a line, there is an equal amount of
space before and after it. Centering adds emphasis and draws the read-
er’s attention to the text.

You will find that the location of centered text on your screen depends
on the margins you have set. If you change the margins, you must recenter
the text. The cursor may be anywhere in the line when you enter Ctrl-O,C
or Shift-F2.

NOTE: When you are centering several lines, Ctrl-O,C must be entered
on each separate line that is to be centered.

To center text, complete thesc steps:
Open a file named CENTER.
In column 1, type the first line of text. Use Caps Lock to capitalize text.
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WORDSTAR

MOVIE CLASSICS

BUSINESS COMMUNICATIONS

ELECTION DAY

(2] Press Ctrl-O,C or shift-F2 to center the line.

@ Press Return.

(4] Continue to center cach line following the steps given.
5] Press F10 or Ctrl-K,D to save the document.

s Tab Settings

Many electronic typewriters have presct tab stops every five spaces.
WordStar is similar to the electronic typewriter in that it also provides
default (preset) tabs every five spaces. Tab locations are marked on the
ruler line by exclamation points. Standard tabs are tabs you set, ones
which may be different from the dcfault tabs. A third type of tab is the
indent tab used to indent text from the set left margin.

Default (Preset) Tabs

When a file is open, the ruler line marks default (preset) tab locations by
using the exclamation mark (!) as shown here:

L L ! ! ! ! ! ! ! | ! ! ! R

Default tabs are set at columns 6, 11, 16, 21, 26, 31, 36, 41, 46, 51, and 56.
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Deleting a Default Tab

(] [« B[R]

@] ]

[4]
(5]

To delete any one of the default tabs, follow these steps:

Open a file named TABS.

Practice moving the cursor with the Tab key.

Press Return to move the cursor to column 1.

Clear the default tabs at these locations only: 6, 11, 21, 31, 41, 51.
a. Press Ctrl-ON.

b. When the prompt “Enter a tab stop to be cleared” appears, type 6 to
delete the tab at that position.

c. Plfess Return. v N
d. Continue pressing Ctrl-O,N to clear only the tabs specified.
To practice tabbing and typing text, follow these steps:

Tab to the first remaining tab stop (column 16), and type the text shown in
the sample following.

Tab to the next column, type the text, and continue tabbing and typing the
text.

Press Return after the last word in the last column to move the cursor to
the next line.

Tab ~ Tab  Tab  Tab Tab
Ibook dcard {pencil {ruler | paper

label stamp tray pen erasure

Continue typing text for the second line.

Press F10 or Ctrl—K,D to save the file.

Deleting a Tab at Cursor Position

To delete a tab at the cursor position, read these steps. (These apply to all
tabs, not just default tabs.)



Tab Settings 65

1. Place the cursor in the column which contains the tab you want to de-
lete.

2. Press Ctrl-O,N.

3. PressEsc.’

Deleting All Default Tabs

(3] [] [B] [H]

(]

During editing, it may be necessary to use tabs other than the default tabs.
It is sometimes easier to clear all default tabs and then set the new tabs.

To clear all default tabs, study these steps:

1. Press Ctrl;O,N. |

2. Type A.

3. Press Return.

To practice clearing all default tabs, follow these steps:
Open a file named AUTOS.

Clear all default tabs.

Save the file with F10 or Ctrl-K,D.

Open the file AUTOS and notice that the default tabs have been re-
stored.

Abandon the file with Ctrl-K,Q.

Setting Standard Tabs

@] [@] [3] [@] [N] =]

New tabs must be set in your files from time to time. The tabs you set are
called standard tabs.

To set standard tabs, complete these steps:

Open a file named FOOTBALL.

Clear all default tabs.

Set line spaéing for single.

Press Ctrl-O,1 to set a new tab.

When the prompt “Enter new tab stops” appears, type the tab number, 10.

Press Return.
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Continue pressing Ctrl-O,I and typing the number to set standard tabs at

30 and 53. Press Return to complete the operation.

Type the sample text.

Tab Tab Tab
10 30 53
Jets Cowboys Oilers

Packers Dolphins Redskins

@ Press F10 or Ctrl-K,D to save the document.
@I Print one copy.

When you open this file again, the default tabs will be automatical-
ly restored.

s Indenting Text

B [ N[

You can sct a temporary left margin at a tab position. Here is an example
showing text indented at the first default tab (6), with margins set at 1
and 65. The line length is 60. Notice that a “V” is shown in the ruler
line. Justification is turned off using Ctrl-O,]. ‘

L V. ! ! } ! ! ! ! ! J ! R
Be sure to use the "wrap-around” feature as you are
typing paragraphs. Remember, do not press the retumn
while typing; WordStar will retum for you.

To set a temporary left margin, complete these steps:
Open a file named INDENT.
Turn off Justification.

Press Ctrl-O,G to sct a temporary indent at the first default tab. Notice
that a “V” appears at the first tab position.

Type the sample text. Each line will automatically begin at the first de-
sired default tab.
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You can locate the preset tabs WordStar has marked for
you by looking at the ruler line below the menu. [Return
twice]

Notice that the “V” disappeared from the ruler line after pressing Re-
turn. A hard return cancels the temporary left margin.

Press Ctrl-O,G to indent the second paragraph.
Type the sample text.

Most electronic typewriters have preset tabs every five
spaces. WordStar also provides this feature.

Press F10 or Ctrl-K,D to save the document.

NOTE: 1. When a temporary left margin is set, a “V” is shown in the
ruler line. The cursor, however, will not move until typing be-
gins.

2. Pressing Return cancels the temporary margin. Ctrl-O,G must
be pressed before each new paragraph to reset the temporary
margin.

3.To align text after editing, place the cursor on the first line of
the paragraph and press Ctrl-O,G, then press Ctrl-B.

To edit and align text after using a Ctrl-O,G command, follow these steps:
Open the file named INDENT.
Make these revisions:

a. In the first line of the first paragraph add immediately following You
can.

b. In the first line of the second paragraph add Today as the first word of
the paragraph, and change Most to most.

Position cursor in line 1; press Ctrl-O,G.
Press Ctrl-B to align first paragraph.
Continue to second paragraph to align text.
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(€]

Press F10 or Ctrl-K,D to save document.

Print one copy.

s Changing Margins

(Bl @] 0] [B] [0 [] [«] [N] [=]

WordStar automatically sets the left margin at 1 and the right margin at
65, allowing 65 characters per line in the text boundaries. When you use
Ctrl-O,L or Ctrl-O,R for margin changes, these changes are only in effect
while you are working on the document. When the document is saved and
opened again, the default margins will appear.

To change the left margin, complete these steps:
Open the file named INDENT.

Press Ctrl-O,L.

Enter the new left margin, 12.

Press Return.

Leave this file on your screen to use in the next practice exercise.
To change the right margin, complete these steps:
Press Ctrl-O,R

Enter the right margin number, 57.

Press Return.

Leave this document on your screen.

NOTE: 1. You must recenter a title when you change margins on a docu-
ment you’ve already begun.

2. If you change your mind or make a mistake after entering
Ctrl-O,L or R, use Ctrl-U to interrupt the command.

Aligning Text Quickly

The margins for the file named INDENT are changed to 12 and 57, but the
lines of each paragraph still appear within the old margin settings.
Each paragraph must be aligned to adjust the lines to your new margins.

If you have only one paragraph to align, study these steps:



Changing Margins 69

1. Move the cursor to the first line of the paragraph to be aligned.
2. Press Ctrl-B to align the paragraph.
To align a file with several paragraphs, complete these steps:

[1] Move the cursor to the beginning of the file INDENT.

[2] Press Ctrl-Q,U. Each paragraph will be aligned throughout the docu-
ment.

@ Press F10 or Ctrl-K,D to save the document.

NOTE: Use Ctrl-B to align each paragraph typed with a temporary
left margin. (Ctrl-U cannot be used to reform paragraphs that
were typed with a temporary left margin.)

Saving Margin Settings

When you exit a file, the default margins of 1 and 65 and the default tabs
will reappear, as will all default settings. If you want to save the margin
changes you made during editing, enter either the dot command .LM or
.RM, and the column number for the new margin. When you later revise
the document, margins remain where you set them rather than having the
default margins restored.

To save the margins, follow these steps:
Open the file named ERRORS.
Press Ctrl-N to insert a blank line at the top of the page.

Enter .LM, space once, and type the column number for the new left margin,
5.

Press Return.

Enter .RM, space once, and type the column number, 60, for the new right
margin.

Place the cursor in column 1 of the first line.

Rl [ [@ B [« N[

Press Ctrl-Q,U to align the text.

These margins will be saved with the document.

Press F10 or AK D to save the document.
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—Summary—

Onscreen formatting means that text appears on your screen almost exactly
as it will appear when it is printed on the paper.

The Onscreen Format Menu lists commands for setting margins, tab loca-

tions, line spacing, and centering text.

Dot commands can also be used for onscreen formatting. Unless deleted,

they will be saved along with the text.

To display the Onscreen Format Menu, press Ctrl-O.

To change line spacing, press Ctrl-O,S and enter the number for the de-
sired spacing, and then press Return. Or enter .LS and the space re-

quired on a blank line, then press Return.

To turn Justification on or off, press Ctrl-O,] or enter .OJ on (or off).

To center text AOC

To delete a default tab AQON, column number, Return

To delete a tab stop at the cursor’s position *ON, Esc

To clear all default tabs AONA, Return

To set standard tabs AQI, column number, Return

To interrupt AON; AOI; or other commands AU

To set a standard tab at the cursor position O], Esc

To set a temporary left indent (margin) OG

To set a left margin AOL, column number, Return

To set a right margin AOR, column number, Return

To align several paragraphs AQU

To align text AB at beginning of
paragraph

To set margins using dot commands, begin in column 1 on a blank line and
key in .LM (or .RM), space once, type the column number for the new mar-
gin, then press Return.



Typing Tables

For speclal emphasis, greater understanding,
and ease of reading, some types of information
are best presented In table form. For Instance,

SALES BY TERRITORY
Eastern ~ Western  Southern
1985 1,798,005 976,543 675,421
1986 923,476 2,397,324 1,689,430
1987 3,110,295 2,546,875 2,764,321

In Chapter 5 you learned how to work with tab
settings. In this chapter we will learn how to
use tabs to create columns of text.

' n



s Guidelines for Typing Columns

When typing columns, you should turn off or change certain features, such
as Insertion and Word wrap; this increases the efficiency with which you
can keyboard columns of information. A file must be displayed on your
screen to make these changes.

Prior to typing tabulated material:

1. Turn off Insertion by pressing the Ins key (or AV). When this toggle
switch is off, a change in one column does not affect other columns on
the same line.

2. Turn off Word wrap with AOW if text will extend beyond the right
margin. When this feature is off, your text will not wrap automatical-
ly into the wrong column.

3. When necessary, release the margins with 2OX.

4. Set a ruler line for the table width with AOL and AOR (or use .LM and
.RM). If you are editing a table, be sure the ruler line agrees with the
width of the table.

To make the proper adjustments for typing columns, complete these steps:
Open a file named COLUMNS.
[2] Be certain margins are set at 1 and 65.
[3] Turn off Insertion with Ins or AV.

[4] Leave the file open to use in the next practice exercise.

Shortcut for Typing Columns

A shortcut can be used to simplify typing columns of information. Study
this sample text:
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Parachute Durable light-weight nylon
Quilt Coat Classy designer-look full-length
Chenille Bedspread = Twin, full, or queen-size

To practice this shortcut, complete these steps:

Type (in column 1) a set-up line using the longest word (or group of words) in
each column plus the desired number of spaces between columns. Treat the
line as if it were one long word.

You type Chenille Bedspread [6 spaces] Classy designer
look full-length

Press AOC.
Clear all default tabs using “ON and A.

Place the cursor at the beginning of each column and set a tab using ~OI,
Esc.

Delete the set-up line using Y.

Type the table.

NP [ B« W]

Press F10 or KD to save the document.

s Typing a Table Using Decimal Tabs

In business it is often necessary to type tables that include columns of deci-
mal numbers. Typing such a table is easy using decimal tabs, because you
do not have to worry about the way numbers will align. The rule is that
decimal points align vertically, as shown here:

1.997
23.01
6
2,314.55099

When decimal tabs are used on a word processor or computer, the num-
ber you type will automatically move to the left until you type a decimal
point, all digits typed thereafter will fill in to the right of the decimal
point. The command *OI sets decimal tabs.
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The difference between default and decimal tabs is shown on the ruler
line: the decimal tab is marked with the symbol # instead of !. The stat-
us line will display “DECIMAL TAB” when the cursor stops at a decimal
tab stop.

To type a table with decimals, follow these steps:
Open a file named BUDGET.

Clear all default tab locations with AON and A.
Press Return.

Set a standard tab at column 16 by pressing ~OI, typing 16, and pressing
Return.

Set a decimal tab at column 51 as follows:
a. Press "OL

b. When the prompt “Set tab at column (escape for cursor column)?” ap-
pears, notice the statement above it: “For decimal tabs, precede the
column number with a #.” The symbol # must be typed before the
decimal point column number, #51.

c. Type #51.
d. Press Return.
Steps a-d must be followed to set each decimal-tab # stop.

Type this sample table.

BUDGET [Return three times]

[Tab] 1987 [Tab] $12,347.62 [Return]
1986 1,450.89
1985 10,341.56
1984 9,980.71

Press F10 or AKD to save this document.
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| Summary_

Before typing tabular material:

Turn Insertion off Insor AV
Turn Word wrap off AOW
Release margins AOX

Set the margins for the desired width of the table. Use default tabs or
standard tabs for text and whole numbers; use decimal tabs for numbers con-
taining decimals.

Symbol for default tab !
Symbol for decimal tab ~ #
To set a decimal tab AQ], #, column number, Return

To clear all default tabs AONA, Return
To clear a decimal tab Cursor in decimal tab column, *ON, ESC



Printing Features

WordStar provides commands to create a va-
riety of special effects that give emphasis to
printed textual material. Certain words,
phrases, etc., are made to stand out in some
manner. Two methods you are probably most
familiar with are boldface printing and under-
lining.



s Boldface Printing

Boldface words or phrases are printed darker, bolder than all the sur-
rounding text. This special printing effect brings attention specifically to
words in boldface. Boldface can be used, for example, in chapter headings
or anywhere where text requires special emphasis.

All Print commands are entered by typing AP followed by a letter. The
WordStar Print command for boldface is APB (B for boldface). The com-
mand is placed before and after the text in boldface print. (The IBM PC
command is F4.) The P will not appear on your screen, only B will ap-
pear. The F4 key will place the boldface command in the text for you
also. Study the following sample:

ABComputers™B
The August/September issue of ABU.S. Education®B
stated that seventy-five percent of all future workers
will need to use computers in some aspect of their work
and that there could be a need for over two million new
technical specialists, both with and without degrees,
by 1990.

Notice that, in this example, B appears onscreen before and after
both the title of the article and the name of the periodical, so those
words will print in boldface. If the words are in a title, type APB (or F4)
before and after the title, then use AOC to center it. If the words are with-
in the paragraph of text, type APB (or F4) before and after the words. Re-
member, the code P (for print) will not appear on your screen.

To print boldface, follow these steps:
[1] Open a file named COMPUTERS.



2]

[3]
(4]

[5]

(6]
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Type the title in boldface.
Center the title with 2OC.
Press Return three times, to leave two blank lines after the title.

Type the paragraph with the name of the periodical in boldface.

ABComputers®B
The August/September issue of ABU.S. Education™B
stated that seventy-five percent of all future workers
will need to use computers in some aspect of their work
and that there could be a need for over two million new
technical specialists, both with and without degrees,
by 1990.

Press F10 or AKD to save the document.

Print one copy.

e Underlining

[] [%] K]

Underlining is one of the most common types of special effects used in
printing. To produce underlining, press APS (a standard WordStar com-
mand) before and after the words or phrases to be underlined. The IBM PC
provides a special-function key for underlining, F3, to save keystrokes.
Usually, it is preferable not to underline spaces between underlined words
in a group.

Study this example of underlining a single word:
Typing ASEmployeesS produces Employees.

NOTE: Be very careful with this type of on/off print command. If you
forget to turn off Underlining, you could have several pages of
underlined text.

To underline, complete these steps:
Open a file named WORLD.
Center and capitalize the words World Care for the title.

Single-space the body and underline the words World Care each time they
appear.
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WORLD CARE [Return three times]

You have probably noticed the World Care flag flying
under the U.S. flag in front of the Champion Building.
We fly this World Care banner with pride and in recogni-
tion of all our employees who support this worthy cause.
The World Care, through one unified campaign, provides
support and assistance to 55 agencies with 213 service cen-
ters. These agencies in turn serve the handicapped, the
sick, the aged, the young, the mentally ill, as well as
those who have no other place to turn to keep their lives
together. The lives of all of us will be affected in some
way by the work of the World Care. Again, let me say
thanks!

NOTE: When inserting the APS (or F3) Print command for underlining,
notice that the line that contains the command extends outside
the ruler line on your screen. The printed copy will, however,
be correctly aligned.

E‘_'—_l Press F10 or AKD to save the file.
@ Print one copy.

mmm Typing Binding Spaces

It is often important that WordStar not divide a phrase at the end of a
line of type. Examples of phrases that should not be divided are proper
names, dates, times with a.m. or p.m., and numerals. To avoid such divi-
sions, WordStar provides the command APO, which places a binding
space between two characters, preventing Word wrap or Paragraph align
from separating two words. Suppose you were typing the name of a prod-
uct called Republic II. To avoid a break anywhere in the name, you could
type a binding space between the two words, instead of pressing the space-
bar, whenever you type these words. The screen will show only AO. Study
this example:

...this unique Republic*Ollautomobile. . .

When you return to an existing file and make changes, for example, bind-
ing spaces assure that those words remain together.
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To {ype text using binding spaces, complete these steps:
[1] Open a file named REPUBLIC.

@ Single-space the sample text, placing binding spaces between the words of
the proper name Republic II each time it occurs so that it will not be di-
vided during printing,.

One of the most reliable automobiles designed this
decade is the Republic II. Roundabout Motors provides
many styles, colors, and sizes of this unique Republic II
automobile. If you have not recently visited
Roundabout Motors to drive the new Republic II, come
by today and do so. The Republic II would provide
added comfort and convenience for your family.

[3] Press F10 or AKD to save the file.
[4] Print one copy.

“Summary“

WordStar IBM PC
Boldface APB F4
Underline APS F3
Binding space APO PO



Finding and Replacing
Text

WordStar has the ability not only to search for
a word but to replace that word automatically
with a new word. For example, it is very easy
to change a monthly report title from Septem-
ber to October. To accomplish this, you instruct
WordStar to find the word September and re-
place it with the word October. WordStar
moves the cursor to the first occurrence of
September, deletes it, and then inserts the new
month—October.



s Find and Replace Commands

A string is any sequence of characters. WordStar allows you to find a
string of up to 65 characters. When you are searching for something in a
file, you must be at the beginning or end of the file to search through it
completely. When the string is found, you may want to insert text, simply
check what is there, or make changes in the string. If the string is justified
with extra spaces or divided by wrapping to the next line, WordStar will
be unable to locate it.

WordStar uses three find and replace commands. These are

1. Find a string ("QF).

2. Find a string and replace it with another string (*QA).

3. Find or find and replace the next occurrence of the same string (*L).

These commands search forward, from the cursor position.

Finding a String
[1] To find a string, complete these steps:
[2] Open a file named LONGHORN.

@ Type the following sample text. Remember to use a binding space for “No-
vember 27” and for “6:30 p.m.”

The Annual Business Meeting of the Longhorn Council
will be held on Tuesday, November 27, at 6:30 p.m. It will
be held at the Overland Park Methodist Church at 1005
Briarhaven Road, which is right next to the Post Office
in Fort Worth.
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Enclosed is your official coordinator ribbon which will
allow you to vote and to represent your institution at the
Annual Meeting.

Election of 1987 officers and board members, as well as
other important business items, will be taken care of. We
believe it’s important for you to be present at the Annual

Meeting to represent your institution and to be a part of
the traditional Longhorn Council democratic procedures.
We'll also have some fun and fellowship.

Please return the reservation slip below. Cost of the
meal is $6.

[4] Position the cursor at the beginning of the file.

@ Press AQF.

@ When the prompt “Find what?” appears, type the string to be located:
Longhorn. Be certain to type an uppercase L.

Press Esc. (The cursor will be positioned at the beginning of the string.) If
this string is what you are looking for, you may make changes at this
point: change the spelling to Langhorn.

Press AL to move the cursor to the next occurrence of the string of words.
Keep pressing AL until all the desired strings are located.

[@]

When the message “End of scarch for: Longhorn Press Esc to continue” ap-
pears, press Esc. At this point, you may return to the last occurrence of the
string by pressing Esc and ~QV, or you may return to the beginning of the
file by pressing Esc and ~QR.

Press F9 or AKS to save your file on the screen.

NOTE: Press AU to stop a find operation before it ends.

s Replacing One String with Another String
To find one string and replace it with another string, follow these steps:

@ Position the cursor at the beginning of your file.
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Press 2QA.

When the prompt “Find what?” appears, type the string to be replaced:
Langhorn Council

Press Return.

When the prompt “Replace with?” appears, type the new string: Group
No. 441

Press Esc.

NPl (@B [«

When the cursor finds the first occurrence of the string, the prompt “Re-
place (Y/N)?” appears in the upper right corner of your screen. Press Y for
yes.

Press AL to continue the replacement.

When the message “End of scarch for: Langhorn Council” appears, press
Esc.

Align the paragraphs ("QU).

Press F10 or AKD to save the document.

EIE [ [

NOTE: 1. When the placement string is long and words extend past the
right margin, align the paragraph using AB.
2. A long string may not be found if the text is justified since ex-
tra spaces may have been inserted within the string.

e Finding and Replacing with Options

After entering a string, you can sclect the following options when using
AQF (find) or *QA (find and replace). You can choose as many options as
you want. To select an option, type the letter representing the option and
press Return. The commonly used options are shown here.

W Searches for whole words only. For example, if you select this option,
WordStar will not scarch for “it” in “sit,” “edit,” and “position.”

U: Ignores uppercase or lowercase. Select this option to find a string re-
gardless of whether any letter is capitalized or not.

B: Searches backward. Use this option when you are at the end of a file,
or when you know that what you want is somewhere before the cursor
position.

G: Moves to the beginning or end of the file before starting the search.
When used with 2QA, scarches globally through the entire file start-
ing from the beginning (or end).
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N: Replaces the string without asking.
A

: Automatically aligns each paragraph after it replaces a string. After
reaching the end of the paragraph, it returns the cursor to the spot
where the replacement was made.

Practice using these options by completing these steps:
Open the file named LONGHORN.

Search forward using ~QA to find the number 441. Press Return. Replace
the number with 541. Press Return. Select options A, G, and N by typing
those letters. Press Return. The replacement will be made throughout the
file. Press Esc to end the operation.

Press ~QC to go to the end of your file. Use *QA with option B so you can
search back through the file to find 541 and change it to 641. Type Y to an-
swer the prompt after each find. Press AL to continue the search. Press Esc
to end the operation.

Using "QF with W, search from the beginning of the file for the whole
word Annual. When Annual is found, delete it and type Spring. Continue
the search with AL. Press Esc to end the operation.

Use AQR to return to the beginning of the file.

Using AQA, find 641 and replace it with 741, using options A, N, G to
replace the string throughout the file and align paragraphs.

View the document to sce if the changes have been made.

Press F10 or AKD to save the document.

—— S U 71111 2 I Y S ———

To find a string AQF, type string, Esc

To move to the next occurrence of
the string AL

To stop a find or a find and replace
operation before it ends AU

To find and replace one string
with another string AQA, old string, new string, Esc
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To align a paragraph B
To search backward in the text

from the cursor position AQAB or AQFB, Return
To search for whole words only AQAW or "QFW, Return

To search and ignore upper- and
lowercase QAU or "QFU, Return

To make the replacement automatically
throughout the file without stopping
for verification AQAN or “"QFN, Return



Handling Blocks of Text

WordStar provides block commands that allow
you to mark, move, copy, or delete text. These
commands eliminate retyping; the original text
is moved around, copied, etc. WordStar can
move an entire file into another file. To move
an entire file, its text must first be marked for
identification, then placed in a temporary file. A
target file is then opened; the cursor is posi-
tioned at the desired spot to receive the text;
then the text is moved from the temporary file
into the target file. WordStar allows you to
copy, rename, and delete files, and also to re-
store a lost file from the backup file.

WordStar’s spelling corrector helps you to
find misspelled words. With WordStar’s spelling
check commands, you can check the spelling of
a word before you type it in your document or
you can check spelling in a document that has
been completed. See Appendix E for the spelling
check commands.



s Block Commands

Block commands are commands that affect whole blocks (or units) of
text. They appear on the Block & Save Menu. You have already used the
Save commands (AKS, AKD, AKX, AKQ) from this menu. Now you will use
the block commands to mark, move, and delete text.

Marking a Block

@  BIeME]

Before a block can be moved, copied, or deleted, it must be marked at its
beginning and end, so that WordStar can identify exactly what text is to
be affected.

Type the sample letter, completing these steps:

Open a file named QUOTES.

Turn off Justification with AQJ.

Press Tab to indent the numbered paragraphs five spaces.

Set a temporary left margin at the second default tab by pressing *OG
twice after typing the paragraph number and period. The “V” appears in
the ruler line to indicate a temporary indent.

Double space between the numbered paragraphs.

Current Date [Press Return 4 times]

Mr. Joe Rogers, President

Ryan International Corporation

P.O. Box 5589

Longview, TX 75606 [Press Return 2 times]
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Dear Mr. Rogers: [Press Return 2 times]

Enclosed is a request for quotation for ZIP Airline’s coach
dinnerware. Samples are included for your review and
analysis. It is imperative that all information requested
in this quotation be completed in full. Below are some
highlights regarding areas of this quotation request.
[Press Return 2 times]

The tools for each of the dinnerware components are the
property of ZIP Airlines. These tools are in good condition
and have been used for the past two and one-half years.
The relocation of these tools will be at the expense of the
supplier. [Press Return 2 times]

[Tab]1.[Press *OG twice] Prices are to be firm for a two-
year period.

2. Quoted prices shall include palletization and shrink
wrapping/landing of cartons.

3. Prices are to be calculated based on the specified gram
weights.

4. Raw-material price must be stated.

5. Each item’s shipping-carton weight and dimensions
are to be stated.

I am requesting that the contract be bid as stated. I also
encourage any suggestions, by you the experts, to be ad-
dressed separately for review before the award of this
contract. [Press Return 2 times]

Sincerely, [Press Return 4 times]

B. T. Willis
Purchasing Agent [Press Return 2 times]

urs [Press Return 2 times]

Enclosure

21

@ Press F9 or AKS to save the file.
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Position the cursor at the beginning of the text to be marked: move the cur-
sor to the blank line above the second paragraph.

Press Shift and F9 or AKB to mark the beginning of the text; <B> appears
on your screen but will not print.

Position the cursor at the end of the text to be marked: move the cursor to
the blank line below the second paragraph.

Press Shift and F10 or press ~K; release, then press K. Wait—either <K>
appears on your screen or your text is highlighted in some manner. High-
lighting helps you identify the text affected. When your text is high-
lighted, the beginning symbol <B> is removed.

Keep this document on your screen for the next exercise.

NOTE: Remember the word block begins with a b and ends with a k. You
mark the beginning of a block with AKB and the end with AKK.

Moving a Block

(]

CI I

In the previous exercise, you marked the beginning and end of the second
paragraph. Suppose that after you read the letter, you felt the second
paragraph should be placed before the last paragraph, just after the num-
bered list. With a typewriter, you would have to retype the entire letter.
WordStar, however, allows you to make the adjustment easily. If you
move the wrong block of text, simply put it back and begin the procedure
again.

To move a marked block of text, follow these steps:

Return to the file named QUOTES. Position the cursor at that place in the
file you want to move the text: move your cursor to the blank line above
the last paragraph.

Press Shift and F7 or press ~K; release, then press V. The marked text
moves to the cursor position.

View your document to determine if any blank lines need to be added to ac-
commodate the move.

Press F10 or AKD to save the document.
Print one copy.

NOTE: After you have moved a block of text, the text may remain
highlighted. It is recommended that you turn off the block dis-
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play (*KH or Shift-F6) at this point for two reasons: (1)
WordStar works faster when the block display is off, and (2) a
block could be accidentally erased (AKY) if the block is still
highlighted.

Deleting a Block

E R Ele B NE

To delete a block of text, follow these steps:
Open the file named QUOTES.

Position the cursor at the beginning of the text to be deleted: move the
cursor to the blank line above the first paragraph.

Press AKB or Shift and F9 to mark the beginning of the block.

Move the cursor to the end of the text to be deleted: move the cursor to the
end of the second sentence.

Press AKK or Shift and F10 to mark the end of the block.

Press AKY or Shift and F5 to delete the marked block. The block disap-
pears, along with the markers.

Check your screen to see that the text was deleted.

Press AKQ and answer the prompt to abandon the file.

mmmmmmmmn Copying a File

1]
[2]

3]

To copy a file means to make another record of the file on the disk. This
copy is sometimes called a backup copy and is named using the same file
name with the extension .BAK added. If another name is used, two exact
duplicates of the file exist with different names. It is often helpful to
make a second copy for editing purposes and keep your original intact.
Then you can return to the original should you decide against the changes
you’ve made.

To copy a file, complete these steps:

From the Opening Menu, press O. (When a document is on the screen, press
AKO.)

When the prompt “Document to be copied?” appears, type the file name.
Type QUOTES.

Press Return.
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@ When the prompt “Name a document to hold the new copy” appears, type
the new name: QUOTESA.

[E Press Return.
The directory will show both file names.

NOTE: You can use the exact same file name if you copy from one drive
to another, but you cannot have two files with the same name
on the same disk.

Deleting a File

When files are no longer needed, it is important to delete them to provide
more storage space on your disk.

To delete a file from the Opening Menu, complete these steps:

PressY.

When the prompt “Document to be erased?” appears, type the file name:
QUOTESA.

Press Return.

Bl [NE]

The prompt “Are you sure (Y/N)?” appears. Type Y for yes.
The directory will show that the file name no longer exists.

NOTE: To delete a file when a document is on the screen, press ~KJ and
respond to the prompts. You cannot delete the file you are edit-

ing.

s Ecliting a Backup File

The first time you save a file, you have only one version of the file.

WordStar makes a backup copy of the file the next time you save the file.

Notice those files in your directory with the same file name as the origi-
nal but with the .BAK extension. These are backup files. If your original
document is damaged or lost, you can use the backup file. However, you
cannot open the backup file and edit it. To edit a backup file, you must
copy it and give it another name. Then open that new file to edit it.

Before you restore a backup file, delete the file named INDENT.
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Suppose you now discover that you should not have deleted this file.
Let’s restore the file.

To restore a lost file from a backup file, complete these steps:
From the Opening Menu, press O.

When the prompt “Document to be copied?” appears, type the file name:
INDENT.BAK.

Press Return.

When the prompt “Name a document to hold the new copy” appears, type
the file name of the lost file. The name used must be different from any
other file name on the directory. Type INDENT. ' '

Press Return.

The directory will show both the original file name and the backup file
name. At this point the text in both files is identical.

s S UMM ATy S —

To mark the beginning of a block
of text AKB or Shift and F9

To mark the end of a block of text AKK or Shift and F10

To move a marked block of text AKV or Shift and F7

To delete a marked block of text AKY or Shift and F5

To copy a file o (from Opening Menu), file
name to be copied, Return, new
file name, Return

To delete a file Y (from Opening Menu), file
name to be erased, Return, Y
(for Yes) .

To restore a lost file from O, backup file name, Return,

the backup file old file name, Return



Paging, Creating
Headers and Footers

WordStar, like most other word-processing pro-
grams, provides a command that automatically
breaks or separates the text into pages. Be-
cause there may be instances when WordStar
will break a page at an undesirable point, such
as in the middle of a table, WordStar also pro-
vides commands to control the page-making
function. In this chapter, you will learn how to
set and change page breaks using dot com-
mands.

Up until this chapter, you have been printing
one-page documents. Chapter 10 presents
WordStar’'s print options for multipage docume-
nts. We will look at these first.



Print Options

So far in this manual, we have used the Escape key to print files. This
step bypasses the default print options and prints the file immediately.
However, if you press Return after you have named the file to print, the
following options appear on your screen:

Number of copies? You can print more than one copy of the file. The de-
fault is one copy.

Pause between pages? If you need to feed individual sheets of paper to
the printer, you must press Y for pause between each page. The default is
no.

Use form feeds? If you want to use a sheet feeder when moving to the
next page of a printout, answer Y for yes. You must answer yes if you are us-
ing a sheet feeder. The default is no.

Starting page? You can start printing at any page of a multipage docu-
ment. The default is page 1. If you want printing to begin on another page,
enter the selected beginning page number, followed by a Return to advance
to the next option, or press Esc to exit the option list. You can also specify
individual pages and ranges of pages to print. To do this, type the first
page number of a sequence, a hyphen, and the last page number in the se-
quence (1-4). Separate individual page numbers with commas (1, 3, 5) or
(1-4, 5, 7). When you type page numbers in this way, WordStar skips the
“Ending page?” prompt.

Ending page? You can end the printing at any page of a multipage docu-
ment. The default is the end of the document.

Nondocument? To print a nondocument, press Y for yes. Nondocument
files are data files or computer programs.

Name of printer? The default is the printer you chose during installa-
tion. To select a printer other than the default, you can type a printer
driver name and press Return.

After you answer the last prompt (or press Esc), printing begins.

NOTE: Pressing Esc starts printing immediately; pressing Return ad-
vances you to the next print option.
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Pause Printing

Occasionally, you may want to interrupt or stop the printer while printing
a document. For example, when printing a multipage document, it may be
necessary to tell WordStar to pause at the end of each page so that paper
can be inserted into the printer. To pause between pages, answer Y at the

“Pause between pages?” option before you start printing.

Study these steps to pause printing between pages:
1. Press P from the Opening Menu.

2. When the prompt “Document to print?” appears, enter the file name.
Press Return.

3. Press Return to advance to the option “Pause between pages (Y/N)?”.
4. Type for yes.

5. Press Return to proceed through the remaining print options or press Esc
to start printing.

6. When the printer pauses, insert paper.
7. Press P to display the Print screen.

8. Press C to continue printing.

s Pagination

The function of breaking down text into pages is commonly called
pagination. WordStar automatically breaks text into pages as you type,
automatically numbering the pages as it goes. Using dot commands, you
can change the place where the automatic page break occurs or simply end
a page of text short and begin a new one. (A list of dot commands is given
in Appendix A.)

Cancelling Automatic Page Numbering

In the WordStar—Educational Version, the page numbers will print only
by using a special headline (header) or baseline (footer). These are ex-
plained later in the chapter.

WordStar’s default condition is set to print page numbers at the bot-
tom margin in column 28. If you wish to leave the pages unnumbered, you
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can cancel this default condition by typing the dot command .op beginning
in column 1 at the top of your file. To re-enter the default condition, type
the dot command .pn beginning in column 1 at the top of your file.

NOTE: To number pages starting somewhere other than page 1, use the
dot command .pn n (substitute the page number for n). The
printed pages will be numbered according to this command.
Therefore, if you want to start numbering with page 22, use the
dot command .pn 22.

s Setting Page Breaks

WordStar indicates page breaks by displaying a horizontal line of hy-
phens across the screen, ending with a P in the flag column. This line does
not print. An example of the page-break line is shown here.

Because of that program, we’ve brought the inflation rate
down to the lowest levels in twenty years. Interest rates,
though still too high, are down from the level of a year
ago.

-—-- -—-- - P

The economic recovery brought about by our tax cuts and
spending restraint is more than just numbers. It’s hope and
opportunity for millions of Americans.

Conditional Page Breaks

Page breaks must be checked to see if they are positioned at satisfactory
points in the text. If a particular break in text is not acceptable, you can
instruct WordStar to keep text together by setting a conditional page
break.
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To enter a conditional page break, study these steps:

1. Count the number of typed lines you want to keep together above and
below WordStar’s original page break.

2. Move the cursor to column 1 of the first line of the lines to be kept to-
gether.

3. Press AN to create a blank line. WordStar will not count this line.

4. Type .cp, space once, and type the number of lines to be kept intact, for
instance .cp 5

This tells WordStar that these five lines must be kept together. If they
cannot be kept together on this page, WordStar will move all of them to
the next page. When you type .cp 5, the WordStar page-break line auto-
matically moves to the line on which the conditional page-break com-
mand was typed. If there is enough room on this page to include all the
lines before the break, WordStar will move them up. Otherwise, they
will appear at the top of the next page.

NOTE: In double-spaced documents, .cp entered between the lines eras-
es the blank line separating them. Be certain to press AN before
typing the .cp command.

Unconditional Page Breaks

If you wish to determine the exact makeup of a page of text, WordStar
provides a dot command called an unconditional (forced) page break.
When you enter the page break command .pa, it will appear on your screen
as shown in this example.

Because of that program, we’ve brought the inflation rate
down to the lowest levels in twenty years. Interest rates,
though still too high, are down from the level of a year
ago.

.pa

The economic recovery brought about by our tax cuts and
spending restraint is more than just numbers. It's hope and
opportunity for millions of Americans.
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To set an unconditional page break, complete these steps:
Open a file named CREDIT.
Turn off Justification.

Change to double-spacing.

[&][] B[]

Type the following sample text. [P] means to begin a new paragraph. In-
dent each paragraph.

Furthermore, Bradford is committed to paying high
competitive interest rates on accounts of $2,500 or more
and is determined to provide one of the most attractive in-
vestment alternatives available. The fact is, since the in-
troduction of our new account last year, we have
consistently outperformed the average of all leading mon-
ey market funds and accounts. [P] It all means that so-
phisticated investors like yourself can now get high inter-
est, FDIC insurance protection (up to $100,000), and the
security of dealing with one of the most respected finan-
cial organizations in the world: Bradford Bank. [P] En-
closed also is a brochure that tells you more about Brad-
ford’s Money Market Account. We urge you to take a few
moments to look it over. [P] Then, to open your account,
simply complete and return the enclosed form along with
your check or money order for $2,500 or more—and don’t
forget to affix your cash bonus sticker. As soon as we re-
ceive your deposit, we will immediately open your ac-
count and send you the Bradford Money Market Account
Agreement by return mail. [P] Or, if you prefer to wire
your deposit, call us toll free at:

1 800 200-1200

and refer to the reservation number of the enclosed coupon.
It guarantees you priority service.

@ Press F9 or AKS to save the document on your screen.

@ Position the cursor where you want the page to end or break: place the
cursor in column 1 on the first line of the fourth paragraph.
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[7] Press AN to provide a blank line. WordStar will not count this line.

Type .pa to begin a new page. The line indicating the page break will
jump to the position under the unconditional page-break command.

|§_| Press Return.

You should have the first three paragraphs on page one and the last two
paragraphs on page two.

@ Press F10 or AKD to save the document.
@ Print one copy of each page.

NOTE: If you need to stop the printer to insert another sheet of paper
while printing a multipage document, remember to answer Y for
yes after the “Pause between pages?” print option.

To summarize, a page-break (.pa) dot command forces a page break at the
exact point where you want to begin a new page. A conditional page-
break dot command (.cp followed by the number of lines to be kept togeth-
er) makes certain that a block of text will not be split between two pages.

Deleting a Page-break Command

To delete either a .pa or .cp dot command, press AY to remove the entire
line.

s Typing Headers

A header is repetitive information containing special text, a page number,
or a notation that prints at the top margin of every page and helps to
identify its content. It may be used on every page, every page but the first,
every other page of a document, or in other combinations. Headers may be
used in a multipage document to identify the document by title, page num-
ber, date or any combination of these. For example, a header may appear
like this on all pages except the first in a multipage report.
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Part I—Funding Recommendations

Staffing, training, and equipment needs must be considered for the year. In
order to proceed with the recommendations, the

The line may appear at the left, as shown in the previous example, at the

right, or centered at the top of the page.

A dot command (.he) is used to type a header. Study the following illus-

tration:

1 space
{

.he Part [Funding Recommendations

The header dot command occupies four spaces on the screen (he and a
space) but it will not print. Therefore, the repetitive information after
the header dot command on the screen will appear four spaces to the right

of where it will actually print.

Study these steps to enter a header:

1. Press AN to insert a blank line.

2. Type .he (for Header), starting in column 1.
The .he may be upper- or lowercase.

3. Press the spacebar once.

4. Type the header information.

NOTE:: Be certain not to leave a blank line above the .he command
placed at the top of a page. Leaving a blank line will prevent

the header from printing.

If you do not leave a blank space between the header dot command and

the repetitive information, the header will NOT print.

NOTE: 1. For a header to print on all pages beginning with the first
page, enter the header dot command in column 1, line 1, page 1.

2. For a header to print on all pages after the first page, enter
the header dot command anywhere except on line 1 of page 1 or

on line 1 of page 2.
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Cancelling a Header

To cancel a previously entered header command, press AN to insert a blank
line and enter .he with nothing typed after it, and press Return. The com-
mand may be entered at the top of any page. If you want the header to
print on following pages, type a new header dot command and text, then
press Return.

Numbering Pages in a Header

To include a page number in the header, the automatic page numbering at
the bottom of the page must be omitted by entering .op in column 1 at the
beginning of the document before the header dot command.

NOTE: You will not have to enter .op (omit page number) in the Word-
Star—Educational Version to include a page number in a
header.

Page Number at Right

The following header is shown with its text at the left and the page num-
ber at the right.

( CREDIT TERMS 3

To include a page number with text, the symbol # is typed wherever the
page number is to be placed. When printing, the page number will replace
the symbol #. Study the following illustration.

.he CREDIT TERMS #

To enter a page number in a header, follow these steps:
Open the file named CREDIT.
@ Type .he in column 1.
[3] At the top of the second page, press ~N to insert a blank line.
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@ Press the spacebar once.
[5] Type the header text: CREDIT TERMS.

[6] Tab and space to position the cursor where you want the page number and
type #. To position the page number at the right, place the symbol in col-
umn 69 of the header. The symbol is placed in colum 69 because the head-
er takes up 4 spaces in addition to the 65 spaces set for the right
margin,thus 69 spaces.

Save and print one copy of each page.
Page Number at Center

You may want to have only a page number at the top of each page, with-
out any text. This illustration shows the header dot command that prints
a page number at the center of the line.

( .he #

To print a page number at center, study these steps:

1. Press AN to insert a blank line.
Enter the symbol #.
Press AOC (for Center).

Position the cursor at the beginning of the line by pressing QS or A «— .

o~ 0NN

Be certain Insert is turned off, then enter .he and a space.

e Typing Footers

A footer is repetitive information containing special text, a page number,
or some other notation printed below the text within the bottom margin.
Footers can serve two purposes: (1) numbering pages and (2) drawing the
reader’s attention to a special message. These two purposes are illustrated
here.

Footer Shown with Page Number:
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L Part I—Funding Recommendations 2

Footer Shown as a Special Message:

L Your Business Is Our Futurel

The footer command eliminates the default page number. You may contin-
ue to print the page number at center and add text with a footer dot com-
mand (.fo) as shown here.

t fo CREDIT TERMS #

To enter a footer dot command, follow these steps:
Open the file named CREDIT.
[2] Use AY to delete any previously entered header dot command.
[3] On the second page below the text, type .fo in column 1.
[4] Press the spacebar once.
(5] Type text in all capitals: CREDIT TERMS.

[6] Position the cursor wherever you want the page number to occur and type
the page-number symbol #. Type the symbol in column 36.

Save and print one copy of each page.

NOTE: 1. When a footer command is used, no page number will print at
the bottom of the page unless the page-number symbol # is in-
cluded in the footer dot command.

2. Once a footer dot command is entered, it will print on every
page until it is cancelled.

Cancelling a Footer

To cancel a footer dot command, press *N and enter .fo and press Return. To
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re-enter a footer dot command, press AN and type .fo and the appropriate
text, then press Return. If you cancel all footers, the automatic page

numbering is restored.

NOTE: Headers and footers may contain up to three lines of informa-
tion.

To define such headers and footers, use these dot commands.

.he or .h1 (first header) fo or .f1 (first footer)

.h2 (second header line) .f2 (second footer line)

.h3 (third header line) £3 (third footer line)

_Summary—

Press Esc to bypass print options.

Press Return to advance to next
print option.

To cancel automatic page numbering op

To re-enter the numbering page default  .pn, number of page

To set a conditional page break .cp, number of lines, Return
To set an unconditional page break .pa, Return

To delete a page-break command AY to delete entire line

To enter a header dot command .he (space) info

To cancel a previously entered header .he

To enter a page number in a header he (space) info, #

To enter a footer dot command fo (space) info

To enter a page number in a footer fo (space) info, #

To cancel a previously entered footer fo
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s Summary of WordStar Commands

Flag Column Commands

<

Line ends with a hard carriage
return, entered by user

A line ends with a soft carriage
return produced by word wrap
within a paragraph.

A new page begins below this
line.

Line ends with a form feed pro-
duced by the APL command.

File ends on or above this line.

Text extends beyond the right
edge of the screen.

Dot command on this line changes
the onscreen format and the
printout.

Dot command on this line changes
only the printout.

Dot command on this line is not
recognized by WordStar.

Dot command on this line changes
the onscreen format and the
printout; it works best if it's
placed at the beginning of a
page.

Line ends with a carriage return
but without a line feed, as speci-
fied by AP.; it will be overprint-
ed by the next line.

Line ends with a line feed char-
acter produced by APJ instead of
a carriage return.

Beginning block marker is in this
line.

End block marker is in this line.

Cursor Mo
T or”E

4 or~X
«or”S
—orAD

-\

AF

AQR

/\Qs

I\QB

AQK

QC

AQD

AQP

AQE or Home
AQXor End
AQI

vement Commands
Up one line
Down one line
One letter left
One letter right
One word left
One word right
To beginning of file
To beginning of current line
To block beginning
To block end
To end of file
To right end of line
To previous cursor position
To top of screen
To bottom of screen

To page you specify

Block Commands

AKB
AKC
AKY
AKK
AKH
AKV

AKR

AKW

Begins block mark
Copies block

Deletes block

Ends block mark
Hides/shows block mark

Moves block to cursor posi-
tion

Copies another file to cursor
position in the current file

Writes block to a separate
file

4NN
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Dot Commands

AW on/off
.CPN

.FO text
.HE text
.LMN
LSN
.MB N

MTN

.OJ on/off
.OP
.PA

PG

RMN
.RR ruler

.UL on/off

Turns aligning and
wordwrag};gng/off

Inserts a conditional page
break

Prints text as footer
Prints text as header

Sets left margin in column
Sets spacing between lines

Sets number of lines from
end of text area to bottom
of page

Sets number of lines from
top of page to beginning of
text area

Turns justification on/off
Omits page numbers

Starts a new page at indi-
cated line

Turns printing of page num-
ber on if it was turned off
with .OP

Sets right margin in col-

Embeds ruler line ruler in
file

Turns underlining of space
between words on and off

Function Keys

F1 Help Shift F1
F2 Undo Shift F2
F3 Underline Shift F3
F4 Bold Shift F4
F5 Delete Line Shift F5
Fé6 Delete Word Shift F6
F7  Align Shift F7
F8 Ruler Shift F8
F9 Save and Shift F9
F10 Done Shift F10

Insert and Delete

AKY
AKJ
AG or Del

AQ Del
AQY

QT

AT

Alns or AV

AN
Y

Deletes a block
Deletes a file

Deletes character at cur-
sor

Deletes to beginning of
current line

Deletes to end of current
line

Deletes all characters up
to next occurrence you
specify

Deletes word to right
Turns insert on/off
Inserts a blank line
Deletes current line

File/Disk Options

AKL

AKO
"KJ

AKP
AKE

Display
Center
Check Rest
Check Word
Delete Block
Hide Block
Move Block
Copy Block
Begin Block
End Block

Changes logged disk
drive or directory

Copies a file
Deletes a file
Prints a file
Renames a file



Format Commands

AOC Centers text

AON Clears tab stops

oG Sets temporary left margin
AOF Sets ruler line from format

that cursor is in

AOI#N- Sets decimal tab stops

AOL Sets left margin

AOSN Sets line spacing

AOR Sets right margin

AOI Sets tab stops

B Reforms paragraph

AOX Releases margins

NOJ Turns justification on/off

AOP Turns previewing on/off

AOD Turns display of print con-
trols on/off

Print Commands

P Prints from the Opening
Menu

Shift PrtSc  Prints the screen

AKP Starts printing

Print Controls

APB Boldfaces

APD Double strikes

APO Inserts a required space

APC Stops printing at this spot

APS Underlines

Save Commands

AKQ Abandons editing; without
saving, returns to Opening
Menu

AKD Saves and exits to Opening
Menu

AKX Saves, exits WordStar

AKS Saves and remains in cur-
rent file

APrtSc: Saves file; displays print

options
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Help Commands

N Enters help system

AJ? Displays help with screen
layout

Al Displays help with dot
commands

NN Changes the help levels

Menus

D Displays Edit Menu, opens
file

WS From DQOS, starts Word-
Star and displays Opening
Menu

AK From Edit Menu, displays
Block and Save Menu

O From Edit Menu, displays
Onscreen Format Menu

AP From Edit Menu, displays
Print Controls Menu

Q From Edit Menu, displays
Quick Menu

Miscellaneous Commands

AQF Finds a string of text

AQA Finds and replaces one
string

QQ Repeats next letter or com-
mand

AU Interrupts command; re-
stores most recently delet-
ed text

AKN Turns Column Mode on/off

AOF Sets Ruler Line from the
format of text line that the
cursor is in

Speller Commands

AQN Checks spelling of word at
the cursor
QO Checks spelling of word

that you enter
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s \WWordStar Menus

Opening Menu

The Opening Menu appears when you start WordStar. It contains com-
mands that allow you to start operations on files.

OPENING MENU
D open a document L change logged drive/directory
N open a nondocument C protect a file
P print a file E renane a file
M merge print a file 0 copy a file
I index a documMent Y delete a file
T table of contents F turn directory off
X exit WordStar Esc shorthand
J help R run a DOS command

To choose a command at the Opening Menu, type the command letter. To
cancel an Opening Menu command before starting the operation, press AU.

Edit Menu
EDIT MENU
CURSOR SCROLL ERASE OTHER MENUS
“E up “W up “G char “~J help “0 onscreen formMat
“X doun ~Z doun “T word “I tab “K block & save
S left “R up screen Y line “U turn insert off “P print controls
“D right “C doun Del char “B align paragraph "Q quick functions
“A uword left screen “U unerase "N split the line Esc shorthand
“F word right “L find/replace again

While you're editing a file, this menu is always displayed if your help
level is set to 3. If your help level is other than 3, you can press 2] to display
the Edit Menu, then press the Spacebar to remove the menu display. The
help level determines whether or not the menu is normally displayed.

To use an Edit Menu command, hold down the Ctrl key while you press
the command letter. -
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Block & Save Menu

BLOCK & SAUVUE HENU
SAVE BLOCK FILE

S save & resume edit B mark begin C copy 0 copy P print

D save document K mark end U move E renane

X save & exit WordStar H turn display on Y delete J erase

Q quit without saving W urite to disk M math L logged drive/dir
CURSOR N turn column mode on R insert a file

8-9 set/remove marker I turn column replace on F run a DOS command

To see the Block & Save Menu, press AK. You can choose any of the com-
mands on the menu by pressing the corresponding key. To cancel the menu
without choosing a command, press the Spacebar.

WordStar displays the menu only if the help level is set to 2 or 3. You
don't need to see the menu in order to use its commands. Just enter the three
keystrokes quickly and the menu doesn't appear. If the help level is set to
0 or 1, the menu does not appear.

Onscreen Format Menu

ONSCREEN FORMAT HMENU

MARGINS TYPING DISPLAY
L set left U turn word urap off D turn print controls off
R set right J turn right justify off H turn hyphen help on
X release E enter soft hyphen P turn previeu on
T turn ruler off G temporary indent B turn soft space dots on
F ruler from text S set line spacing TABS
0 ruler to text C center line I set tab stop N clear

To see the Onscreen Format Menu, press 2O. You can choose any of the com-
mands from the menu by pressing the corresponding key. To cancel the menu
without choosing a command, press the Spacebar.

WordStar displays the menu only if the help level is set to 2 or 3. You
don't need to see the menu in order to use its commands. Just enter the three
keystrokes quickly and the menu doesn't appear. If the help level is set to 0
or 1, the menu does not appear.
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Quick Menu

This menu contains quick versions of many Edit Menu commands. It also
contains commands for finding and replacing and for checking spelling
while editing. The commands are grouped under six headings, CURSOR,
FIND, ERASE, SPELL, SCROLL, and OTHER.

QUICK HENU

CURSOR FIND OTHER SPELL
E upper left P previous F find text U align paragraphs L check rest
X louer right U last find A find/replace M math Q repeat N check uword
S left side B beg block G char foruard ERASE 0 enter uord
D right side K end block H char back ¥ line to right SCROLL
R beg doc 8-9 marker I find page Del line to left U up, repeat
C end doc 7?7 char count  <(or lined T to character Z doun

To see the Quick Menu, press AQ. You can choose any of the commands
on the menu by pressing the corresponding key. To cancel the menu without
choosing a command, press the Spacebar.

WordStar displays the menu only if the help level is set to 2 or 3. You
don't need to see the menu in order to use its commands. Just enter the three
keystrokes quickly and the menu doesn't appear. If the help level is set to
0 or 1, the menu does not appear.

Print Controls Menu

This menu contains commands that affect the printed document. The com-
mands are grouped under two headings, BEGIN & END and OTHER.

PRINT CONTROLS MENLU
BEGIN & END OTHER

B bold X strike out H overprint char 0 binding space
S underline D double strike <4 overprint line C print pause
U subscript Y italics/color F phantomn space I column tab
T superscript K indexing G phantom rubout B fixed position

Q U E R custom N normal pitch

L form feed A alternate pitch

To see the Print Controls Menu, press AP. You can choose any of the
commands from the menu by pressing the corresponding key. To cancel the
menu without choosing a command, press the Spacebar.

WordStar displays the menu only if the help level is set to 2 or 3. You
don't need to see the menu in order to use its commands. Just enter the three
keystrokes quickly and the menu doesn't appear. If the help level is set to
0 or 1, the menu does not appear.
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s Formatting a Disk

To save your work on a floppy disk (diskette), you need to format the disk
to record this data.

To Format a Disk for a Dual-Disk-Drive Unit:

1.

7.

Insert the DOS disk in Drive A.

2. Answer the A> prompt by entering: format b:
3.
4

. The screen shows the following message:

Press Return.

Insert new diskette for drive B:
and strike Enter when ready.

. When the process has been completed, the screen shows the following

message:

Formatting . . . Format complete
Format another (Y/N)?

If you answer Y for Yes, the screen instructions are repeated. Replace
the disk with another disk to be formatted.

If you answer N for No, the DOS prompt reappears.

TIP: | To save time, format several disks at a time.

11R
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mesmmmmmm Summary Of WordStar Default Conditions

110

Condition

Type style (Pitch)

Line spacing

Margins:
Side margin settings
Right margin justification
Top margin
Bottom margin

Vertical lines on page
(page length)

Lines of text available for
use before a page break

Page break

Number of blank lines between
heading line and first line
of text

Number of blank lines between
last line of text and footing

Automatic page numbering
Menus

File directory

Insert

Ruler line

Word wrap

Hyphen help

Tabs stops

Print display

Help level

Default
10 characters per inch
Single

1and 65

On

3 lines (1/2 inch)

8 lines (1 1/3 inch)

66 lines, 6 lines per inch on 11-inch page
55 lines of text per page

On

2 lines

2 lines
On, in column 28

QeLLLeQ

f

On, every fifth column
On

3
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memsmmmmmm Spelling Check

WordStar’s spelling corrector goes through the file you are working on,
scanning the words in it and comparing them with correctly spelled words
stored in its computerized spelling dictionary. When a word is found that
WordStar’s spelling corrector thinks is misspelled, it displays the word
on the screen and lets you decide whether to keep it, correct it, or add it in
your personal dictionary.

The spelling corrector has been developed both to reduce the amount
of time spent in proofreading and increase the accuracy of proofreading.
Even though this spelling corrector provides you with an efficient and
useful tool, it does not really read your document or understand its con-
tents. For example, the spelling corrector cannot pick out words that are
correctly spelled but incorrectly used in context, such as “to” for “too.”
WordStar’s spelling corrector simply matches all the words in your file
against all the words in its dictionary files.

WordStar’s dictionary of 87,000 correctly spelled words is stored in
two files: Main.Dct and Internal.Dct. The Third file, Personal.Dct, con-
tains words that are not in the first two dictionaries. The Personal.Dct
file is empty when you first use WordStar. You can store words in the per-
sonal dictionary using the Spelling Check Menu command A.

When you enter one of the spelling check commands, WordStar checks
the spelling of the words in your file against all three dictionary files.
WordStar’s spelling corrector commands appear on the Quick Menu. These
commands are explained here.

Command Action

QL Checks the spelling throughout the entire file beginning at
the current cursor position. QL does not check words used in
dot commands. Use AU to cancel the spelling check before the
end of the file. When WordStar encounters a word that is in
the dictionary, it stops and displays the Spelling Check
Menu, the word in question, and suggestions on how to correct
it.

AQN Checks the spelling of the word at the cursor position. A\QN
checks words used within dot commands. WordStar displays

1417
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QO

the Spelling Check Menu, shows you if the word is spelled
correctly, and displays suggestion.

Lets you type a word and checks its spelling. The word does
not have to be anywhere in your document.

A sample Spelling Check Menu is shown here.

e ~
SPELLING CHECK MENU
I ignore, check next word E enter correction “U quit
A add to personal dictionary T turn auto-align off
B hypass this time only 6 global replacement is off
Word:
Suggestions!
N _/

Each command is briefly discussed here.

Command
1

Action

Ignores the word and goes to the next word. Using *QL, the
word is ignored throughout the file. Using AQN, the next
word in the text is checked. Using 2QO, you can type another
word to check.

Adds the word to the personal dictionary. Once the word is
added, WordStar does not stop at the word each time it ap-
pears.

Bypasses this occurrence of the word but stops at subsequent
occurrences.

Enters the word that you type. The “Replace with” prompt
appears. Type the corrected word and press Return. The word
you type is checked next.

Turns auto-align off and on. The default is on. When Align is
on, WordStar automatically aligns the text when it substi-
tutes a correctly spelled word for the misspelled one.

Turns global replacement off and on. The default is off. When
global replacement is off, WordStar replaces only this in-
stance of the word. When global replacement is on, it affects
only the word currently correct; it is automatically turned
off and the next word checked. When global replacement is
on, WordStar replaces all occurrences of the word in the file
with the correct word you choose.

The word being checked appears below the Spelling Check Menu op-

tinne alnano with aniooeations of correct snellines.



format, 111
help, 111
insert and delete, 110
page break, deleting, 103
print, 111
uick cursor-movement, 50
save, 36-37, 111
speller, 111
toggle, 33
Conditional page breaks, 100-101
Control key (Ctrl), 4, 36
restarting and, 4, 15

I n dex Copies, number printed, 98

Copying, of files, 93-94

Copyright notice, 16
CPU, 6,9
Cursor, 2,16
Cursor diamond, 25, 26, 27
Aligning, 33 Cursor keypad, 25, 26, 27
of paragraphs, 4041 Cursor movement, 25-27, 48-50
of text, 68-69 commands for, 109
Alternate key (Alt), 4
restarting and, 4, 15 Date, 15-16
Decimal tabs, 73-74
Backspace key (<), 4 Default conditions, 32, 116
Backup files, editing, 94-95 Default tabs, 63-65
Binding spaces, 80-81 deleting, 64-65
Block(s%, 9-95 Delete key (Del), 5
deleting, 93 restarting and, 4, 15
marking, 90-92 Deleting, 38-40
moving, 92-93 of blocks, 93
Block & Save Menu, 36, 113 commands for, 110
Block commands, 90-93, 109 of default tabs, 64-65
Boldface printing, 78-79 of files, 94
Booting up, 14-16 of lines, 3940
Bottom margin, 33 of page break command, 103
Byte, 20 of single characters, 38-39
of words, 39
Cancelling Directory, 19-20
of command, 27 Disk(s), 7-9
of footers, 107-108 care of, 8-9
of headers, 105 file/disk options and, 110
Caps Lock key, 5 formatting, 9, 16
Centering, of text, 62-63 logged, 7
Central processing unit (CPU), 6,9 WordStar—Educational Version, 17
Character, deleting, 38-39 Disk drive(s), 7
Column(s), 72-73 dual, formatting with, 115
flag, 23, 34-35, 109 half- and full-height, 7
Command(s), 2, 14, 109-111 in-use light for, 14
block, 90-93, 109 logged, 7,16, 18-19
cancelling, 27 Disk operating system (DOS), 8, 9
cursor movement, 50, 109 booting up with, 14-16
dot, 59, 110 Diskette, see Disk(s)
erase, 48-50 Document. see File(s)
find and replace, 86-87 DOS, 8,9

flag column, 109 booting up with, 14-16



120

Index

Dot commands, 59, 110
Double-sided disks, 7-8
Double-sided drives, 7
Drive, see Disk drive(s)

Dual-disk-drive unit, formatting disks

for, 115

Edit Menu, 22-25,112-113
Editing, of backup files, 94-95
Enter key (), 5

Erase commands, 48-50
Escape key (Esc), 4

Exiting, from WordStar, 28
Extension, 21

File(s), 19-20
backup, editing, 94-95
copying, 93-94
deleting, 94
naming, 21-22
nondocument, 98
opening, 20-22
restoring, 94-95
saving, 35-37
File/disk options, 110
Filespec, 21
Find and replace commands, 84-85
Finding
with options, 86-87
replacing and, 84-85
of strings, 84-86
F-keys, 4,110
Flag column, 23
commands for, 109
hard and soft returns in, 34-35
Floppy disk, see Disk(s)
Footers, 106-108
cancelling, 107-108
Forced page breaks, 101-103
Form feeds, 98
Formatting, 57-70
centering text and, 62-63
changing margins and, 68-69
commands for, 111
of disks, 9, 16, 115
dot commands and, 59
indenting text and, 66-68
justifying text and, 6162
line spacing and, 59-61
onscreen, 58
setting tabs and, 63-66
Full-height drives, 7
Function(s), 2, 14
Function keys, 4, 110

Half-height drives, 7

Hard copy, 11. See also Printing
Hard hyphens, 42
Hard return (<), 33, 34-35
Hardware, 2
Headers, 103-106

cancelling, 105

numbering pages in, 105-106
Help commands, 111
Help messages, 24-25
Hyphen(s), hard and soft, 42
Hyphen-help, 41

IBM PC, 1-11

basic components of, 2-9

terminology for, 2

text processing on, 9-10
Indentation, of text, 66—68
Insert commands, 110
Insertion, 42-44

turning off, 42
Insertion key (0/Ins), 5
Insert-on, 32-33

Justification, of text, 61-62

Key(s)
alternate (Alt), 4
backspace (<), 4
Caps Lock, 5
control (Ctrl), 4, 15, 36
delete (Del), 4, 5, 15
enter (J), 5
escape (Esc), 4
insertion (0/Ins), 5
left shift (), 4
Num Lock, 5
print screen (PrtSc/*), 5
return (J), 5, 42
right shift Mm,5
spec}al-function, 4,110
tab (]), 4, 42
Keyboard, 3-5
Kilobyte, 20

Left margin, 32

Left Shift key (1), 4

Line, deleting, 3940

Line justification, 32

Line spacing, 33
selecting, 59-61

Logged disk, 7

Logged disk drive, 7, 16
changing, 18-19

Margin(s)
changing, 68-69



left and right, 32
saving, 69
top and bottom, 33
Marking, of blocks, 90-92
Memory, 6
Menu(s), 17-19, 111, 112-114
Block & Save, 36, 113
Edit, 22-25,112-113
Onscreen Format, 58,113
Opening, 18, 112
rint controls, 114
Quick, 48-50, 114
Messages, 14
help, 24-25
Monitor, 5-6, 15
Moving, of blocks, 92-93

Name(s), of files, 21-22
Nondocument files, 98
Num Lock key, 5
Numeric keypad, 3, 5, 25

Onscreen Format Menu, 58, 113
Opening menu, 18, 112

Page(s)
ending, 98
ausing between, 98
Page breaks, 100-103
conditional, 100-101
deleting command for, 103
unconditional, 101-103
Page numbering
automatic, cancelling, 99-100
at center, 106
in headers, 105-106
at right, 105-106
Pagination, 99-100
Paper length, 33
Paragraphs, aligning, 4042
Pause printing, 99
Peripheral equipment, 2
Print controls, 111
Print controls menu, 114
Printer, 9
name of, 98
Printing, 53-55, 77-81
binding spaces and, 80-81
boldface, 78-79
commands for, 111
controls for, 111, 114
options for, 98-99
pausing, 99
starting, 53-54
stopping, 54-55
underlining and. 79-80

Index 121

Prompt (>), 14,16

PrtSc key (PrtSc/*), 5

Quick cursor-movement commands, 50
Quick Menu, 48-50, 114

Replacing
finding and, 84-85
with options, 86-87
of strings, 85-86
Restarting, 4, 15
Restoring, of lost files, 94-95
Return(s), hard and soft, 33-35
Return key (), 5, 42
Right margin, 32
Right Shift key (1), 5
Ruler line, 23

Saving
commands for, 36-37, 111
of files, 35-37
of margins, 69
Scrolling, 51-53
Soft hyphens, 42
Soft return, 34-35
Software, 2
Space(s), binding, 80-81
Spacebar, 42
Special-function keys (F-keys), 4, 110
Spelling check, 117-118
commands for, 111
Standard tabs, setting, 65-66
Status line, 22
String
finding, 84-85
replacing, 85-86
Symbols
alternate (Alt), 4
backspace (<), 4
Caps Lock, 5
control (Ctrl), 4, 15, 36
delete (Del), 4, 5,15
enter (), 5
escape (Esc), 4
hard return (<), 33, 34-35
insertion (0/Ins), 5
left shift (T), 4
number lock (Num Lock), 5
print screen (PrtSc/*), 5
prompt (>), 14,16
return (J), 5, 42
right shift (M), 5
tab (5 ), 4, 42
System unit, 6-7

Tab(s), 4, 32, 42, 63-66
decimal 73_7A
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default, 63-65 Text processing, 9-10
standard, setting, 65-66 Time, 16
Tab key (¥, ), 4, 42 Toggle commands, 33
Tables, 73-77 Top margin, 33
decimal tabs and, 73-74
typing columns and, 72-73 Unconditional page breaks, 101-103
Text Underlining, 79-80
aligning, 68-69
centering, 62-63 Word, deleting, 39
indenting, 66-68 Word wrap, 32
justifying, 61-62 WordStar, starting, 17-28

Text editing, 37 Write protect notch, 8



WORDST/AR

from MicroPro International Corporation

MicroPro International Corp. first
introduced the classic WordStar
wordprocessing software package in
1979. Its fame continues to grow after
eight years and multiple improvements
and enhancements later.

Long the favorite of educators,
WordStar has evolved into a powerful,
yet easy to learn (and teach!) product
with a world-wide following of millions
of users. In fact, one of the primary
reasons for its use within the classroom
and lab environments of school
systems and universities is its real-life
applicability following the classroom
learning experience.

MicroPro is not a stranger to the
learning environment. The company
created the Software Endowment
Program in early 1982 and has offered
all of its powerful software programs to
schools at special educational pricing
since that time. Those partnerships with
educational institutions have led the
company to produce a series of
training aids, including courseware and
training guides.

Now, with an eye to the future and
an ear to the words of educators,

MicroPro has both simplified the
method of acquiring its products for
educational use and has opened the
special pricing plan to include faculty
members and students.

With the introduction of WordStar
Classroom, the company is offering the
latest versions of WordStar Professional,
WordStar 2000 Plus and Easy Extra
under a sensible site license agreement.
The program permits a school to pay a
one-time fee for the rights to reproduce
the selected package on groups of 10,
90, or 30 micros within a single room.

As a further step in its commitment
to education, MicroPro has announced
the Personal Purchase Program for
faculty members and students. Now, all
members of the educational arena can
acquire a personal package of any of
MicroPro's wordprocessing programs at
special, educational pricing.

For further information and to
request a catalog and information kit,
contact MicroPro Educational Sales,
PO. Box 2246, Leesburg, VA 22075,
(703) 777-9110.



WORDST/AR

Personal Purchase Program

Officially enrolled students and
bona fide members of institutional
faculty and professional staff may
acquire a personal package of either

WordStar Professional, WordStar 2000
Plus or Easy, Extra at the educational
prices shown below.

Ordering Instructions:

Post-Secondary Students

Submit a photocopy of both your
Student ID Card and one other form of
commonly accepted identification
(driver’s license, etc.)

Secondary School Students
Have your school principal submit a
statement, on school letterhead,
verifying your student status.

Faculty Members

Issue your order on your school’s
letterhead with your professional
business card or faculty ID attached.

WordStar Professional [] $125

WordStar 2000 Plus [ $195
Easy Extra [1$60
Select 5% [J 3% O

Prices subject to change.

Include sales tax with orders from the
following states: CA, VA, GA, NJ, MA,
TX.

To order your personal package of the
selected version of WordStar, submit
your order with a check or money
order to:

MicroPro Educational Sales
PO. Box 2246

Leesburg, VA 22075

(703) 7779110
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Houghton
Mifflin

The Software Solutions Series currently includes:

Using SuperCalc 4™
Using Lotus 1-2-3°
Using WordStar®

Using Microsoft Works®
Using dBASE Il Plus™
Using WordPerfect™
Using PageMaker ™

Manuals in the Software Solutions Series are ideally suited
for use in conjunction with the following texts published by
Houghton Mifflin Company.

Anderson/Sullivan, ‘““World of Computing”’

This state of the art introductory text describes how all types
of computers work and explains principles and concepts
from a user’s perspective.

Sullivan, “Computing Today’’ 2nd edition

The second edition of this widely adopted and highly
respected text provides a comprehensive up to the minute
introduction to microcomputers and their applications.

ISBN: 0-395-47790-5

3-00956





